
MALDI Source

Getting Started Guide

97155-97012 Revision C January 2009

http://www.surveymonkey.com/s.aspx?sm=R7gKOvhLXn3NTkpK2BefHQ_3d_3d 


© 2009 Thermo Fisher Scientific Inc. All rights reserved.

Xcalibur is a registered trademark of Thermo Fisher Scientific Inc. in the United States.

Microsoft, Windows, and Excel are registered trademarks of Microsoft Corporation in the United States and 
possibly other countries.

The following are registered trademarks in the United States and possibly other countries: SEQUEST is a 
registered trademark of the University of Washington. ProteoMass is a registered trademark of Sigma-Aldrich 
Biotechnology LP and Sigma-Aldrich Co. ZipTip is a registered trademark of Millipore Corporation. 
Chromasolv is a registered trademark of Sigma-Aldrich Biotechnology LP and Sigma-Aldrich Co.

LTQ XL, Data Dependent, Dynamic Exclusion, Ion Mapping, ZoomScan, Wideband Activation, 
ImageQuest, and BioWorks are trademarks of Thermo Fisher Scientific Inc. 

OMIX is a trademark of Varian, Inc. 

All other trademarks are the property of Thermo Fisher Scientific Inc. and its subsidiaries
Thermo Fisher Scientific Inc. provides this document to its customers with a product purchase to use in the 
product operation. This document is copyright protected and any reproduction of the whole or any part of this 
document is strictly prohibited, except with the written authorization of Thermo Fisher Scientific Inc.

The contents of this document are subject to change without notice. All technical information in this 
document is for reference purposes only. System configurations and specifications in this document supersede 
all previous information received by the purchaser. 

Thermo Fisher Scientific Inc. makes no representations that this document is complete, accurate or error-
free and assumes no responsibility and will not be liable for any errors, omissions, damage or loss that might 
result from any use of this document, even if the information in the document is followed properly. 

This document is not part of any sales contract between Thermo Fisher Scientific Inc. and a purchaser. This 
document shall in no way govern or modify any Terms and Conditions of Sale, which Terms and Conditions of 
Sale shall govern all conflicting information between the two documents.
Release history: Revision A released February 2008; Revision B released August 2008; Revision C released 
January 2009.

Software Version: Xcalibur 2.1.0 or earlier, LTQ Series 2.6.0 or earlier

For Research Use Only. Not for use in diagnostic procedures.



Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as described in the next section or sections by product name.
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Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

EMC Directive 204/108/EC
EMC compliance has been evaluated by TUV Rheinland of North America.

Low Voltage Safety Compliance
This device complies with Low Voltage Directive 73/23/EEC and harmonized standard EN 61010-1:2001.

Safety of Laser Products
Compliance with safety of laser products is declared under Thermo Fisher Scientific sole responsibility. This device 
complies with the harmonized standard IEC/EN 60825-1/A2: 2001.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
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or one of its authorized representatives.
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FCC Compliance Statement

Notice on Lifting and Handling of
Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher Scientific 
instrument requires a team effort to lift and/or move the instrument. This instrument is too heavy and/or bulky for one 
person alone to handle safely.

Notice on the Proper Use of
Thermo Scientific Instruments

In compliance with international regulations: Use of this instrument in a manner not specified by Thermo Fisher 
Scientific could impair any protection provided by the instrument.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

For manufacturing location, see the label on the instrument.

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.

CAUTION Read and understand the various precautionary notes, signs, and symbols contained inside 
this manual pertaining to the safe use and operation of this product before using the device.



WEEE Compliance

This product is required to comply with the European Union’s Waste Electrical & Electronic Equipment (WEEE) 
Directive 2002/96/EC. It is marked with the following symbol:

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each European Union 
(EU) Member State, and these companies should dispose of or recycle this product. See www.thermo.com/
WEEERoHS for further information on Thermo Fisher Scientific’s compliance with these Directives and the 
recyclers in your country.

WEEE Konformität

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC erfüllen.  
Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-Mitgliedsstaaten 
getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt werden kann. Mehr Information 
über die Einhaltung dieser Anweisungen durch Thermo Fisher Scientific, über die Verwerter, und weitere Hinweise, 
die nützlich sind, um die Produkte zu identifizieren, die unter diese RoHS Anweisung fallen, finden sie unter  
www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS


Conformité DEEE

Ce produit doit être conforme à la directive européenne (2002/96/EC) des  Déchets d'Equipements Electriques et 
Electroniques (DEEE). Il est marqué par le symbole suivant:

Thermo Fisher Scientific s'est associé avec une ou plusieurs compagnies de recyclage dans chaque état membre de 
l’union européenne et ce produit devrait être collecté ou recyclé par celles-ci. Davantage d'informations sur la 
conformité de Thermo Fisher Scientific à ces directives, les recycleurs dans votre pays et les informations sur les 
produits Thermo Fisher Scientific qui peuvent aider la détection des substances sujettes à la directive RoHS sont 
disponibles sur www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS


C

Contents
Preface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xi
Related Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xi
Safety and Special Notices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xii
Contacting Us  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xii

Chapter 1 Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1
What is Matrix-Assisted Laser Desorption/Ionization?. . . . . . . . . . . . . . . . . . . . . 1
Why Use the LTQ XL Mass Spectrometer? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
How Do MALDI and ESI Compare?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
What Are the Data Acquisition Features of the MALDI Source? . . . . . . . . . . . . . 6

Crystal Positioning System (CPS) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Automatic Spectrum Filter (ASF)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Automatic Gain Control (AGC) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

What Types of Experiments Can I Perform? . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
General MS or MSn Experiments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Data Dependent Experiments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Ion Mapping Experiments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

What is Tuning and Calibration of the MALDI LTQ XL System? . . . . . . . . . . 26

Chapter 2 Setting Up the Xcalibur Instrument Configuration . . . . . . . . . . . . . . . . . . . . . . . . .27
Adding the MALDI LTQ XL to the Xcalibur Instrument Configuration  . . . . . 27
Specifying the Ion Source for the LTQ XL MS Detector. . . . . . . . . . . . . . . . . . 29
Viewing or Changing the MALDI Source Configuration Options  . . . . . . . . . . 31

Chapter 3 Preparing for Daily Operation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .33
Using the Equipment and Materials Checklist. . . . . . . . . . . . . . . . . . . . . . . . . . 33
Checking the Helium and Nitrogen Gas Supplies . . . . . . . . . . . . . . . . . . . . . . . 35
Checking the LTQ XL System Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Checking the Vacuum Pressure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Turning the MALDI Source On . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Placing the MALDI Source in Standby Mode . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Rebooting the MALDI LTQ XL System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Thermo Scientific MALDI Source Getting Started Guide vii



Contents
Using the Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Opening the Diagnostics Dialog Box. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Viewing or Printing the Currently Saved Calibration Settings . . . . . . . . . . . . 42
Checking or Selecting the Sample Plate Type  . . . . . . . . . . . . . . . . . . . . . . . . 44
Adjusting the Video Camera Contrast and Brightness . . . . . . . . . . . . . . . . . . 47

Chapter 4 Working with Sample Plates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49
Preparing the Sample Plate  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Disassembling the Sample Plate. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Cleaning the Top Plate of the Sample Plate. . . . . . . . . . . . . . . . . . . . . . . . . . 50
Assembling the Sample Plate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Loading a Sample Plate into the MALDI Sample Module . . . . . . . . . . . . . . . . . 56
Removing a Sample Plate from the MALDI Sample Module. . . . . . . . . . . . . . . 59

Chapter 5 Tuning and Calibrating in the MALDI Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .61
Tuning on an Analyte . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Setting the LTQ XL Parameters for Tuning  . . . . . . . . . . . . . . . . . . . . . . . . . 63
Setting the MALDI Source Parameters for Tuning . . . . . . . . . . . . . . . . . . . . 66
Viewing Mass Spectra in the Tune Plus Window  . . . . . . . . . . . . . . . . . . . . . 71
Tuning the Laser Energy with the Semi-Automatic Function  . . . . . . . . . . . . 73
Adjusting the Laser Energy Manually  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

Calibrating the Mass Spectrometer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Calibrating the Normal Mass Range . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Recalibrating a Failed Item  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Calibrating the High Mass Range . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

Checking the Sensitivity of the MALDI LTQ XL System . . . . . . . . . . . . . . . . . 87
Checking the Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

Chapter 6 Acquiring Sample Data in Tune Plus. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .95
Acquiring Sample Data Interactively in Tune Plus  . . . . . . . . . . . . . . . . . . . . . . 95

Setting the LTQ XL Parameters for Sample Data  . . . . . . . . . . . . . . . . . . . . . 95
Setting the MALDI Source Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Acquiring a Raw Data File in Tune Plus . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

Using an Instrument Method to Acquire Sample Data in Tune Plus. . . . . . . . 102
Setting Up to Acquire MS/MS Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Determining the Optimum Isolation Width . . . . . . . . . . . . . . . . . . . . . . . . 105
Manually Optimizing the Collision Energy . . . . . . . . . . . . . . . . . . . . . . . . . 107
Automatically Optimizing the Collision Energy  . . . . . . . . . . . . . . . . . . . . . 109

Chapter 7 Automatically Acquiring Sample Data with Xcalibur . . . . . . . . . . . . . . . . . . . . .113
Creating an Instrument Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
Creating an Acquisition Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Acquiring Raw Data Files in Sequence Setup. . . . . . . . . . . . . . . . . . . . . . . . . . 128
viii MALDI Source Getting Started Guide Thermo Scientific



Contents
Chapter 8 Tissue Imaging. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .131
Getting a License for the Tissue Imaging Feature  . . . . . . . . . . . . . . . . . . . . . . 132

Getting a New License Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132
Installing a New License Code. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

Preparing Tissue Slides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136
Loading the Tissue Slides onto the Adapter Plate  . . . . . . . . . . . . . . . . . . . . . . 137
Acquiring a Bitmap Image with an External Scanner . . . . . . . . . . . . . . . . . . . . 139
Testing the MALDI Matrix. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Applying the MALDI Matrix to the Tissue Samples . . . . . . . . . . . . . . . . . . . . 144
Importing a Bitmap Image into the Tissue Imaging Page  . . . . . . . . . . . . . . . . 145
Creating a MALDI Position File Using an Imported Bitmap Image . . . . . . . . 150
Creating a MALDI Position File Using the MALDI Camera  . . . . . . . . . . . . . 155
Acquiring Mass Spectral Data from Tissue Samples Using Tune Plus . . . . . . . 157

Interactively Acquiring Data from Tissue Samples  . . . . . . . . . . . . . . . . . . . 157
Using an Instrument Method to Acquire Data  . . . . . . . . . . . . . . . . . . . . . . 159

Acquiring Mass Spectral Data from Tissue Slides Using Xcalibur  . . . . . . . . . . 161
Creating an Instrument Method for Tissue Imaging . . . . . . . . . . . . . . . . . . 162
Creating an Acquisition Sequence for Tissue Imaging . . . . . . . . . . . . . . . . . 163
Checking the Acquisition Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167

Chapter 9 Identifying Proteins Using BioWorks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .171
Using BioWorks to Identify Proteins. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
Opening the RAW Data File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
Defining the Search Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
Modifying the DTA Generation Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Setting SEQUEST Search Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
Searching and Viewing the Results  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178

Appendix A ProteoMass Calibration Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .181
Calibration Kit Description. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182

Storage/Stability  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
Matrix and Solvents. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
ProteoMass Normal Mass Calibration Mix (Product Code C 9241) . . . . . . 182
ProteoMass High Mass Calibration Mix (Product Code C 9366) . . . . . . . . 183
ProteoMass Angiotensin II Sensitivity Standard (A 9854) . . . . . . . . . . . . . . 183

Preparing the Mass Calibration Targets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
Preparing the Solvent Mixtures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184
Reconstituting the Calibration Mixes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184
Preparing the Matrix Solution for the Calibration Targets. . . . . . . . . . . . . . 185
Preparing the Calibrant/Matrix Mixtures. . . . . . . . . . . . . . . . . . . . . . . . . . . 185
Spotting the Calibrant/Matrix Mixtures on the Sample Plate  . . . . . . . . . . . 186

Preparing the Sensitivity Test Targets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186

Appendix B Sample Preparation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .189
Matrix . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190
Thermo Scientific MALDI Source Getting Started Guide ix



Contents
Matrix Solvent. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191
Matrix-to-Analyte Ratio  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191
Sample Purification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191
Sample Deposition Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 192
MALDI Sample Preparation Guidelines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 192

Preparing Samples with the 2, 5-DHB Matrix. . . . . . . . . . . . . . . . . . . . . . . 192
Preparing Samples with the CHCA Matrix . . . . . . . . . . . . . . . . . . . . . . . . . 193
Preparing Phosphorylated Peptides for a Neutral Loss Experiment  . . . . . . . 194

Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .195
x MALDI Source Getting Started Guide Thermo Scientific



P

Preface

This guide describes how to calibrate and tune your MALDI LTQ XL™ system, and how to 
acquire matrix-assisted laser desorption/ionization (MALDI) data. It also provides a brief 
introduction to processing your MALDI MS/MS data using the BioWorks™ data analysis 
program.

Related Documentation
In addition to this guide, Thermo Fisher Scientific provides the following documentation for 
the MALDI source: 

• A printed copy of the Safety and Regulatory Guide

The Safety and Regulatory Guide contains important safety information about Thermo 
Scientific mass spectrometry and liquid chromatography systems. This document is 
shipped with every Thermo Scientific mass spectrometer and liquid chromatography 
device.

• PDF files of the documents in Table 1 that you can access from the data system computer

To access the manuals for the mass spectrometer, from the Microsoft™ Windows™ taskbar, 
choose Start > All Programs > Thermo Instruments > LTQ > Manuals > model and then 
click the PDF that you want to view. 

The software also provides Help. To access the Help, choose Help from the menu bar or click 
the  button on the toolbar.

Table 1. LTQ Series MS documentation

Model Related documents

LTQ™ XL LTQ Series Preinstallation Requirements Guide
LTQ Series Getting Connected Guide

MALDI source MALDI Source Hardware Manual

Note  For Xcalibur version 2.0.7 or earlier, the path is Start > All Programs > Xcalibur > 
Manuals > LTQ > model. 
Thermo Scientific MALDI Source Getting Started Guide xi



Preface
Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

Safety and special notices include the following:

Contacting Us

There are several ways to contact Thermo Fisher Scientific for the information you need. 

To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

To contact Customer Service for ordering information

To copy manuals from the Internet

Go to mssupport.thermo.com and click Customer Manuals in the left margin of the 
window. 

CAUTION  Highlights hazards to humans, property, or the environment. Each CAUTION 
notice is accompanied by an appropriate CAUTION symbol. 

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or contains information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site www.thermo.com/ms
xii MALDI Source Getting Started Guide Thermo Scientific

mailto:us.techsupport.analyze@thermofisher.com
http://www.thermokb.com
http://mssupport.thermo.com
http://www.thermo.com/finnigan
http://mssupport.thermo.com


Preface
To suggest changes to documentation or to Help

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

• Complete a brief survey about this document by clicking the link below.
Thank you in advance for your help.
Thermo Scientific MALDI Source Getting Started Guide xiii
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1

Introduction

The Thermo Fisher Scientific MALDI source produces ions from mixed matrix/analyte 
microcrystals under low-pressure conditions by irradiating these crystals with pulses of light 
from a nitrogen laser. When you use this ion source with the LTQ XL™ mass spectrometer, 
you can perform sensitive analyses of intact molecules, using only small amounts of sample 
material. 

What is Matrix-Assisted Laser Desorption/Ionization?
Matrix-assisted laser desorption/ionization (MALDI) is an effective mass spectrometry tool 
for a wide variety of large, labile biomolecules. By using the MALDI tool, you can transfer 
molecules directly from the solid phase to the gas phase as intact ions. 

As Figure 1 shows, the MALDI method of introducing analyte ions into the mass 
spectrometer includes these basic steps:

1. You mix the analyte with a suitable matrix, dry this mixture on a target plate, and insert 
the target plate into the sample module of the MALDI LTQ XL system.

2. The XYZ mechanism of the sample module moves the target plate into a vacuum 
chamber where the remaining solvent evaporates. 

3. The MALDI nitrogen laser fires pulses of UV light. The MALDI X-Y stage moves the 
selected spot on the target plate in line with the laser beam.

4. The energy from the UV light desorbs the analyte and matrix material from the target 
plate. 
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• What is Matrix-Assisted Laser Desorption/Ionization? 

• Why Use the LTQ XL Mass Spectrometer? 

• How Do MALDI and ESI Compare?

• What Are the Data Acquisition Features of the MALDI Source? 

• What Types of Experiments Can I Perform? 

• What is Tuning and Calibration of the MALDI LTQ XL System? 
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5. The MALDI source grounds the target plate and the LTQ XL mass spectrometer places 
an electrostatic charge on the aperture of the ion transfer optics. In the positive ion 
polarity mode, the LTQ XL mass spectrometer places a negative charge on the aperture. 
In the negative ion polarity mode, the LTQ XL mass spectrometer places a positive charge 
on the aperture.

Figure 1. MALDI sample preparation (panel A) and ionization (panel B)

Because the sample quality affects the production and quality of the ions introduced into the 
mass spectrometer, the most important step in the MALDI process is sample preparation. 
Variables that influence the production and quality of ions with the MALDI source include 
the concentration of the matrix and analyte, choice of matrix, analyte history (for example, 
exposure to strong ionic detergents or formic acid), and contaminants. For more information 
on preparing samples for MALDI analysis, see Appendix B, “Sample Preparation.” 

The preferred method for sample preparation is the dried-droplet method. Using this method, 
you mix a very dilute solution of the analyte (picomoles/microliter to femtomoles/microliter) 
with a solution of the matrix compound. The matrix compound is typically a small organic 
acid that absorbs energy at the wavelength of the laser. To form the sample, you deposit 
approximately 0.5 to 1 μL of the mixture on a target plate. When the mixture dries, a solid 
deposit of analyte-doped matrix crystals remains. The large molar excess of matrix compound 
ensures that the analyte molecules are distributed throughout the matrix crystals. 

During the desorption and ionization step, short pulses of laser light strike the target. Because 
the matrix is in excess and has a high molar absorptivity coefficient at the 337 nm wavelength 
produced by the laser, it absorbs essentially all of the incident radiation, minimizing analyte 
damage and fragmentation. While the actual mechanism of ionization is unknown, the 
predominant theory is that the laser light causes intense heating in the matrix. This heating 
leads to vibrational excitation of the matrix and localized deterioration of the solid solution. 

+

+

+

+

(A) (B)

Matrix

Sample

Target plate

Laser
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The matrix molecules vaporize and form a rapidly expanding plume of ejected material. This 
matrix plume carries some analyte molecules into the vacuum. The ion-molecule reactions in 
the gas phase or simple desorption of preformed ions from solution then ionizes the analyte 
molecules. 

After the analyte molecules are vaporized and ionized, they are transferred electrostatically to 
the mass spectrometer to be analyzed.

Why Use the LTQ XL Mass Spectrometer?
The LTQ XL mass spectrometer provides multiple stages of mass analysis for positive 
compound identification. The LTQ XL also provides features that improve mass resolution 
and enhanced structural information.

The various stages of mass analysis provided by the LTQ XL are as follows:

• Mass analysis (molecular mass information): Single-stage mass analysis provides 
molecular mass information for the identification of analytes of interest.

• MS/MS (structural information): Two-stage mass analysis provides even more positive 
compound identification. MS/MS analysis monitors how precursor ions fragment when 
exposed to an additional stage of ionization. 

There are two types of MS/MS analysis: 

– Full-scan MS/MS: Monitors the production of all product ions from a specific 
precursor ion. 

– SRM MS/MS: Monitors a specific reaction path involving the production of a 
specific product ion from a specific precursor ion. 

Using MS/MS analysis, you can easily quantitate target analytes in complex matrices such 
as plant or animal tissue, plasma, urine, groundwater, or soil. Because of the specificity of 
MS/MS measurements and the ability to eliminate interferences by an initial mass 
selection stage, you can easily accomplish quantitative target compound analysis using the 
LTQ XL mass spectrometer. Due to the complex nature of matrix assisted laser 
desorption, you typically use isotopic labels for quantitation. A discussion on using 
isotope labels to improve quantitation is beyond the scope of this manual.

• MSn (structural information): Multi-stage mass analysis provides the unique ability to 
obtain structural information that can be useful in structure elucidation of peptides, 
carbohydrates, lipids, metabolites, and natural products. MSn techniques on the LTQ 
mass spectrometer allow for stepwise fragmentation pathways, making interpretation of 
MSn spectra relatively straightforward. The LTQ mass spectrometer has several advanced 
features that make its MSn capabilities extremely powerful for qualitative analysis. (See 
“What Types of Experiments Can I Perform?” on page 7.)
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The following features provide higher mass resolution information:

• ZoomScan™ analysis (higher mass resolution information): You collect ZoomScan data by 
using slower scans at higher resolution. In the electrospray ionization mode, you can use 
ZoomScan to determine the charge state, which in turn allows for the correct 
determination of molecular mass. Since MALDI produces almost exclusively 
singly-charged ions, ZoomScan with MALDI is primarily used to provide greater mass 
resolution. 

• UltraZoomScan analysis (the highest mass resolution information) produces the highest 
resolution data of the three scan rates (Normal, Zoom, and UltraZoom).

In addition to providing multi-stage mass analysis and high resolution scans, the LTQ XL can 
perform Wideband Activation™, a technique that applies collision energy to ions during 
MS/MS fragmentation over a fixed mass range of 20 u. This technique enables the LTQ XL 
mass spectrometer to apply collision energy to both the precursor ion and the product ions 
created as a result of non-specific losses of water (18 u) or ammonia (17 u), for example, or 
formed from the loss of fragments less than 20 u. 

Use the Wideband Activation technique for qualitative MS/MS when you want enhanced 
structural information in MS/MS. Because the collision energy is applied to a broad mass 
range, this option reduces signal sensitivity. To compensate for the reduction in sensitivity, 
you can increase the value of the collision energy (Activation Amplitude).

With the MALDI source, you can set up high throughput, automated analyses of target plates 
spotted with 96 or 384 samples. You can also set up tissue imaging experiments on tissues 
fixed to glass or stainless steel slides. Because samples are not completely consumed when 
acquiring data with the MALDI source, they are available for future experiments.

How Do MALDI and ESI Compare?
The addition of a MALDI source to the LTQ XL mass spectrometer means that MSn analysis 
is available for MALDI samples. The most popular MALDI instruments in the past have been 
time-of-flight mass spectrometers, which lack MSn capability.

The biggest difference between MALDI and ESI is in the way that the sample is handled. In 
MALDI, the sample co-crystallizes with a matrix compound that absorbs most of the laser 
energy. A mixture of sample and matrix, when deposited on the MALDI plate, dries to a solid. 
Because the sample is not consumed completely during analysis, you can re-analyze the 
sample at a later date as well as archive it. With ESI, you lose the sample after mass analysis.

MALDI is characterized by speed, simplicity, and ease of automation. MALDI deals with 
mixtures quite well, so chromatographic separation might not be necessary. Furthermore, 
because contaminants tend to be expelled during the co-crystallization of the sample and the 
matrix, MALDI is also less vulnerable than ESI to residual salts in the sample. If needed, you 
can also achieve chromatographic separation offline and deposit the stable samples on the 
plate to be analyzed by MALDI. 
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One of the advantages of the ESI technique is that it offers a lower practical mass limit. ESI 
tends to produce multiple charges, which lower the m/z ratios. Because MALDI is singly 
charged, a higher mass range might be needed for a similar sample. Multiple charging also 
makes MS/MS analysis easier and more informative. Precise sample retention times might also 
aid in mass spectral analysis which is available when you use ESI inline with an LC system.

As ionization types, ESI and MALDI can complement each other. Despite the limitations of 
ESI as shown in Table 1, using both techniques often yields more complete results. For 
protein identification and detection of post-translational modifications, for example, MALDI 
and ESI detect some peptides equally but others exclusively.

One way to combine the methods is to split an LC output between an ESI source and a 
MALDI sample plate and then use the plate as a stable method for reanalyzing selected peaks 
from the ESI run on a MALDI LTQ XL system.

Table 1 summarizes the advantages and disadvantages of both methods.

Table 1. MALDI and ESI strengths and limitations

Method Advantages Disadvantages

MALDI • Sample not consumed during 
analysis

• Simple to use

• Fast analysis

• fmol to amol sensitivity

• Salt tolerance up to mmol 
concentrations

• Suitable for complex mixtures

• Matrix interference at m/z ratios 
below 600

• Produces mostly singly charged 
ions

ESI • With inline LC, can give 
retention time data as well as 
MS data

• fmol sensitivity

• No matrix interference at low 
mass

• Multiple charging, giving 
smaller m/z ratios and improved 
MS/MS

• Poor salt tolerance requires 
elaborate sample preparation

• Chromatographic separation 
required for mixtures leading to 
longer run times and potentially 
additional equipment costs

• Multiple charging can 
complicate spectra
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What Are the Data Acquisition Features of the MALDI Source?
To automate data acquisition and improve the quality of your data, the MALDI source offers 
these features:

• “Crystal Positioning System (CPS),” next section

• “Automatic Spectrum Filter (ASF)” on page 6 

• “Automatic Gain Control (AGC)” on page 6 

Crystal Positioning System (CPS) 

The Crystal Positioning System (CPS) automatically selects crystals of the sample/matrix for 
targeting by the laser during data acquisition. When you enable the CPS, the MALDI 
program processes the camera image of the sample well and identifies the location of the 
crystals in the sample/matrix mixture. The program then calculates a path for the sample plate 
motion that keeps the laser targeted at the crystals and skips over those areas of the well that 
contain little sample deposit. The CPS eliminates the need to manually select the location 
within the sample well where the laser fires, and keeps signal levels consistent even when the 
sample is not deposited evenly in the well. 

In addition to CPS, you can select from a number of predefined plate motion patterns. These 
raster options are spiral outwards, spiral inwards, and zig zag. When using Tune Plus, you can 
also manually select where to fire the laser.

Automatic Spectrum Filter (ASF) 

The Automatic Spectrum Filter (ASF) feature sets the MALDI program to discard spectra that 
do not have a peak height, total area, or signal-to-noise ratio above a specified threshold over a 
specified mass range. When the ASF discards a spectrum, the MALDI source moves the 
sample plate so that the laser targets the next MALDI crystal in the path. ASF ensures the 
acquisition of optimal-signal spectra and speeds data collection by going to fresh crystals when 
the MALDI signal is not optimal. Spectrum filtering, in conjunction with crystal positioning, 
allows for intelligent data acquisition. The ASF feature is not available in Ion Mapping™ 
experiments. 

Automatic Gain Control (AGC) 

The Automatic Gain Control (AGC) feature helps you to maintain the quality of the MALDI 
spectra. When you enable AGC, the MALDI data system adjusts the number of laser shots to 
produce the same number of ions for each scan. If the number of ions produced per laser shot 
is low, the laser fires more shots. If the number of ions produced per laser shot is high, the 
laser fires fewer shots. 
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AGC in MALDI excludes masses below 500 u when it calculates the ion intensity. When 
AGC is on, MALDI spectra are normalized using the number of laser shots and a 
normalization factor. For this reason, you cannot deduce the actual ion counts directly from 
the parameters in the spectrum. To compare the ion counts between spectra collected with 
AGC on or off requires a series of calculations beyond the scope of this manual. 

You have the option of enabling AGC when you operate the MALDI source from the Tune 
Plus program. When collecting data automatically using an acquisition sequence in Xcalibur, 
the experiment uses the AGC mode (either On or Off ) from the tune file specified in the 
instrument method. Figure 2 shows the AGC options on the Control tab in the MALDI 
Source dialog box, accessed from Tune Plus.

Figure 2. AGC options on the Control tab of the MALDI Source dialog box in Tune Plus

What Types of Experiments Can I Perform?
You can perform the following types of experiments with the MALDI LTQ XL system:

• “General MS or MSn Experiments,” next section

• “Data Dependent Experiments” on page 9 

• “Ion Mapping Experiments” on page 21 

General MS or MSn Experiments

A General MS or MSn experiment acquires one type of spectrum: either a full MS or an MSn 
acquisition. The Xcalibur data system includes an instrument method template for a General 
MS or MSn experiment in Instrument Setup. Use a general MS experiment to acquire full 
scan MS data from a whole MALDI plate (96 or 384 sample wells).

Figure 3 shows an example of an MS experiment with one scan event.
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Figure 3. General MS or MSn template with the default settings

You can set the following parameters for an MS experiment: 

• Number of experiments to acquire (how many times a scan event is repeated)

• Maximum acquisition time per sample spot (either the number of experiments or a time 
limit, whichever is achieved first)

• Plate motion (CPS, Spiral Outwards, Spiral Inwards, or Zig Zag)

• Thresholds for ASF settings and their mass ranges

• Tune file (laser energy, AGC option, number of microscans, and number of sweep shots)

• Mass range for the analyte of interest (low, normal, or high)

Plate motion Number of 
experiments

Maximum acquisition 
time

ASF
thresholds

ASF 
mass ranges

Tune fileScan
event
settings
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• Scan rate (normal, Zoom, or UltraZoom)

Typical scan rates with MALDI are normal and Zoom. Use UltraZoom when scanning 
the normal mass range of up to m/z 2000. (The Turbo scan rate is used with an LC run in 
electrospray mode to increase the number of scans across a chromatographic peak. With 
ESI, the Enhanced scan rate provides charge state identification up to charge state 3.)

• Scan type (full or selected ion monitoring, SIM)

• Profile or centroid, positive or negative ion mode

• Scan range values, as defined by the first mass and last mass in the scan range or the center 
mass and width

In Xcalibur, click Help to learn more about each of these parameters.

For an MSn experiment, you also specify the mass-to-charge ratios of all the precursor ions of 
interest, the isolation width, and the collision energy in the MSn settings. The LTQ XL mass 
spectrometer collects data on the ions in the range or on the product ions of the precursor ion 
or ions that you specify.

The LTQ XL mass spectrometer can generate analyte-specific spectra that you can reproduce 
from laboratory to laboratory. Consequently, you can use reference spectra generated with the 
LTQ XL mass spectrometer to confirm structures of compounds generated with other 
LTQ XL systems.

Data Dependent Experiments

Because they can provide structure elucidation, Data Dependent experiments are useful for 
the qualitative analysis of unknown compounds. A Data Dependent experiment can produce 
a composite spectrum of MS2, MS3, and MS4 data, and the program can store the MSn 
fingerprint data in a custom MSn library spectrum. The data is valuable for use in process 
control, quality assurance, or research.

You can approach the setup of Data Dependent experiments in two ways:

• If you know the precursor ion, or if you expect a certain kind of precursor ion, you can set 
up a list of possible precursor ions so that when the mass spectrometer detects one of the 
specified precursor ions, it acquires product spectra. You can also set up a list of ions that 
you do not want the mass spectrometer to fragment.

• If you have little information about your compound, you can set up the parameters of a 
Data Dependent experiment so that the LTQ XL mass spectrometer generates product 
spectra when the intensity of the ion signal is above a specified threshold. Parameters that 
you can specify include threshold values for the intensity of the MS or MSn ion signal. 
The threshold values you choose should successfully isolate the precursor ions of interest. 
These threshold values differ from the ASF thresholds found in the Xcalibur Instrument 
Setup.
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You can use the templates in the Xcalibur Instrument Setup in a Data Dependent experiment 
to do the following:

• Identify low-level peptides in complex mixtures of enzymatically digested proteins (using 
Data Dependent MS/MS or Nth Order Double Play). 

• Identify post-translational modifications (such as phosphorylation and glycosylation) 
automatically from intense precursors in a complex peptide mixture (Data Dependent 
Neutral Loss). 

• Identify post-translational modifications through a hypothesis-driven approach by adding 
the mass of the modification to the identified peptides that could harbor such 
modifications and placing these in a Precursor List.

• Identify proteins by peptide mass fingerprinting using a full MS at ZoomScan rate or 
using the first full MS from the Nth Order Double Play experiment, using the 
deisotoping option in BioWorks. See Chapter 9, “Identifying Proteins Using BioWorks.” 

• Quantitate isotopically labeled peptides from a ratio of peaks in the same MALDI 
spectrum.

Instrument Setup contains the following templates for setting up Data Dependent 
experiments: 

• Data Dependent MS/MS Template, next section

• Data Dependent Triple Play Template on page 12

• Nth Order Double Play Template on page 14

• Nth Order Triple Play Template on page 19

Data Dependent MS/MS Template

Even in the simplest data-dependent experiment (Data Dependent MS/MS template) where 
you specify the MS scan range but do not specify a precursor ion, you can automatically find 
useful structural information about your compound. With these parameters, the LTQ XL 
mass spectrometer collects full-scan MS data over the specified range, picks the most intense 
precursor ion in the spectrum, and then fragments the ion to generate product ions. 

Figure 4 on page 11 shows the default settings for the Data Dependent MS/MS template. 
With the default settings, this template has two scan events. The second scan event is data 
dependent. 
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Figure 4. Data Dependent MS/MS template with the default settings
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As Figure 5 shows, you can use the Data Dependent MS/MS template to set up neutral loss 
experiments. 

Figure 5. Data dependent settings for a Data Dependent MS/MS experiment

Data Dependent Triple Play Template

A Data Dependent Triple Play experiment collects full-scan MS data, and then uses 
ZoomScan to determine the charge state of the precursor ion. With the m/z information 
obtained from the full-scan MS data and the charge state information obtained from the 
ZoomScan, the program calculates the molecular mass of the precursor ion. The precursor ion 
is then fragmented into product ions (MS/MS). Because MALDI ions are predominantly 
singly charged, this experiment type is more useful for the ESI mode.

Figure 6 on page 13 shows the Data Dependent Triple Play template with the default settings.
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Figure 6. Data Dependent Triple Play template with the default settings

Three scan events

ZoomScan
scan rate
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Nth Order Double Play Template

Because the Nth Order Double Play Data Dependent experiment automatically performs 
MS/MS scans on multiple ions with intensities above a specified threshold, it is the most 
common type of experiment performed with the LTQ XL mass spectrometer in both the 
ESI and MALDI modes. For this type of experiment, specify the number of times that 
Scan Event 2 repeats. The data-dependent scans (Scan Event 2) are performed on the N most 
intense ions detected in Scan Event 1, starting with the most intense ion and proceeding in 
order of decreasing intensity. You can collect up to 50 MS/MS scans in a single experiment 
and you can acquire up to 10000 experiments per data file. For MALDI, limit the number of 
experiments per data file to two. See Figure 7 and Figure 8.

Figure 7. Nth Order Double Play dialog box

Selects the N most 
intense peaks in the 
MS scan.
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Figure 8. Nth Order Double Play template (with advanced features)

Figure 9 on page 16 shows some common settings for the Dynamic Exclusion™ parameters in 
an Nth Order Double Play experiment. You can use the dynamic exclusion parameters to 
maximize the number of compounds analyzed in the MS/MS scans.

Exclusion duration and Exclusion mass width (by mass) are the two most important dynamic 
exclusion parameters. Set the exclusion duration to a value greater than the expected time to 
perform the method. Set the exclusion mass width to an m/z range that includes the whole 
isotopic envelope of the precursor ion to ensure each MS/MS scan is of a unique (by 
molecular weight) precursor. Figure 10 on page 17 shows an example of the isotopic envelope 
of Melittin, a peptide in the High Mass Calibration Mix. With an exclusion mass width of 
1.50 m/z on the low end and 4.0 m/z on the high end of the mass range, the LTQ XL mass 
spectrometer performs an MS/MS scan on the most intense peak at 2846.82 m/z and ignores 
the remaining peaks between 2845.32 m/z and 2850.82 m/z.

For MALDI, limit the number of 
experiments to 2.
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Repeat count and Repeat duration are used with LC-ESI-MS experiments. 

Figure 9. Nth Double Play experiment (Dynamic Exclusion parameters)
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Figure 10. Isotopic envelope of Melittin (peptide in the High Mass Calibration Mix)

Figure 11 on page 18 shows the Experiment parameters for an Nth Order Double Play 
experiment. By default, none of the check boxes are selected. These features are generally not 
used for a MALDI experiment.
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Figure 11. Nth Order Double Play (Experiment parameters)

Figure 12 shows the default Current Scan Event parameters in an Nth Double Play template. 
The settings on the Current Scan Event parameters page determine how the dependent scan is 
executed or not executed. The dependent scan event is only executed if the selected ion 
satisfies all specified criteria in a prior scan event. 

Figure 12. Nth Double Play experiment (Current Scan Event parameters)
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Nth Order Triple Play Template

Use this template to set up a special type of Data Dependent Triple Play experiment. In this 
experiment, specify the number of ions (N) you want to further analyze in the independent 
scan performed in Scan Event 1. 

The dependent scans are performed on the N most intense ions detected in independent 
Scan Event 1. These start with the most intense ion (N=1) and proceed in the order of 
intensity (N=2, 3, 4, and so on.) In Scan Event 1, the maximum number of ions that can be 
selected is 9. 

Data Dependent Zoom Map Experiments

A Data Dependent Zoom Map is an Ion Mapping™ experiment that collects ZoomScan data 
on every scan interval in a specified mass range, as well as data-dependent MS/MS product 
spectra on every mass above an intensity threshold.

A Data Dependent Zoom Ion Map experiment consists of an independent MS ZoomScan 
scan that isolates precursor masses in the Zoom mass range—the range of isolated precursor 
masses as specified by the ZoomScan width. During subsequent cycles through this step, the 
parent (precursor) mass is incremented by the Zoom mass step size. ASF settings are not 
available in this experiment.

Figure 13 on page 20 shows the Data Dependent Zoom Ion Map template with default 
settings.
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Figure 13. Data Dependent Zoom Ion Map template with default settings

Data Dependent Ion Tree Experiments

The Data Dependent Ion Tree experiment provides methods for automatically collecting and 
interpreting MSn data and arranging the data in formats that are easy to manipulate. You can 
specify a particular precursor ion for fragmentation, or you can let the LTQ XL mass 
spectrometer find the precursor ions automatically and fragment them to any level between 
MS2 and MS10. The LTQ XL mass spectrometer automates the collection of data by 
determining what actions need to occur next for the experiment to progress. Using these 
methods, you can perform Data Dependent MSn scans on up to 25 ions per scan. 

Tip  To review the data, open the raw data file in Xcalibur Qual Browser, and view the ion 
map by choosing View > Ion Map.
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In an Ion Tree experiment, use the Breadth Focus or Depth Focus option to prioritize how the 
LTQ XL mass spectrometer gathers information. Independent of the focus type (Depth or 
Breadth), specify a maximum depth and a maximum breadth for the experiment. The 
maximum depth is the maximum MSn levels analyzed. The maximum breadth is the 
maximum number of ions analyzed at each MSn level.

Breadth Focus characterizes the specified number of ions at the same MSn level before 
advancing to the next MSn level. For example, if you specify a Max Breadth of 3 and a Max 
Depth of 3, the mass spectrometer performs MS/MS scans on the first, second, and third 
most intense peaks in the MS scan. It then performs MS3 scans on the first, second, and third 
most intense peaks in the MS/MS scan. 

Depth Focus characterizes an ion by performing a series of MSn-level fragmentations (for 
example, MS/MS, MS3, MS4) before characterizing the next most intense ion in the MS scan. 
For example, if you specify a Max Depth of 4 [MS4] and a Max Breadth of 2, the mass 
spectrometer performs the MS/MS, MS3, and MS4 scans on the first most intense peak of the 
MS scan. Then it performs the MS/MS, MS3, and MS4 scans on the second most intense 
peak of the MS scan. 

You can review the results of a Data Dependent Ion Tree experiment in the Xcalibur Qual 
Browser window. The results are displayed as a structure tree that originates from a particular 
precursor ion. 

Ion Mapping Experiments

Use an Ion Mapping experiment to get full structural characterization of unknown molecules 
in complex mixtures. In an Ion Mapping experiment, you can get product ion scans on every 
precursor ion over a specified mass range. An Ion Mapping experiment can help to identify 
automatically which precursor ions were fragmented to yield a specified product ion. The 
experiment maps one or more precursor ions by using the information from product ion 
scans. 

The ion mapping experiments for the LTQ XL are: 

• “Total (Full-Scan) Ion Mapping Experiments,” next section

• “Neutral Loss Ion Mapping Experiments” on page 23 

• “Precursor Ion Mapping Experiments” on page 25 

Note  The Total Ion Map, Neutral Loss Ion Map, and Precursor Ion Map experiments 
described in this topic are not Data Dependent. 
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These Ion Mapping experiments require a stable signal throughout the length of the 
experiment. To achieve signal stability, it is important to prepare homogeneous sample spots. 
For best results, use the Crystal Positioning System (CPS) feature of the MALDI source to 
help maintain signal stability. The Automatic Spectrum Filtering (ASF) feature is not available 
for Ion Mapping experiments, because it could interfere with maintaining a stable signal. See 
“What Are the Data Acquisition Features of the MALDI Source?” on page 6 for more 
information about these features.

Total (Full-Scan) Ion Mapping Experiments

In a total (or full-scan) ion mapping experiment, you get product ion scans for each precursor 
ion. These scans provide information that you can use to determine which precursor ions lost 
a particular fragment to yield a particular product ion. You can also determine which 
precursor ions are related to specific product ions. For example, you can map the spectral 
peaks in a mass range from m/z 600 to m/z 2000 and scan for MS/MS product ions in 
incremental steps of every mass-to-charge ratio, every fifth mass-to-charge ratio, or every tenth 
mass-to-charge ratio. Figure 14 on page 23 shows an example of the settings for a Total Ion 
Map experiment.
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Figure 14. Total Ion Map settings

Neutral Loss Ion Mapping Experiments

A neutral loss ion mapping experiment collects scans for masses that have lost neutral 
fragments. As with full-scan ion mapping, you can get product ion scans on every precursor 
ion. However, a neutral loss ion map experiment identifies which precursor ions lost a neutral 
fragment of a particular mass. For example, you can specify a neutral loss of 80 u (as in the 
case of a phosphorylated peptide in a tryptic digest). A neutral loss ion mapping experiment 
can step through each product mass in the mixture searching for evidence of the loss of a 
neutral moiety of mass 80 u. See Figure 15 on page 24.

CPS plate motion

Parent mass range Product mass range
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Figure 15. Neutral loss ion map settings

Parent mass range Neutral mass range
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Precursor Ion Mapping Experiments

A precursor ion mapping experiment identifies all the ions that produce a particular molecular 
ion. For example, if you specify a product ion mass of m/z 100, a precursor ion map includes 
all the precursor ions (parent ions) that yielded that product ion. See Figure 16.

Figure 16. Parent ion map settings

Parent mass range Product ion mass
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What is Tuning and Calibration of the MALDI LTQ XL System?
Tune parameters are instrument parameters (for example, laser energy) whose values can vary 
with the type of experiment or analyte being mass analyzed. Tuning the instrument on an 
analyte of interest ensures sensitivity and mass resolution.

Calibration parameters are instrument parameters whose values do not vary with the type of 
experiment. You calibrate the mass spectrometer to ensure mass accuracy. Thermo Fisher 
Scientific recommends that you calibrate the mass spectrometer at least once every three 
months, or whenever you notice a decrease in system performance. 

To tune and calibrate the MALDI LTQ XL system, you perform these basic steps:

1. Prepare a fresh calibration mixture and spot it onto a target plate. 

2. Acquire a mass spectrum of the calibration mixture to make sure that the mass 
spectrometer is operating properly and that you can get a good signal. 

3. Use the automatic tuning procedure in Tune Plus to ensure a laser energy that is high 
enough to produce a good signal-to-noise ratio for the ions in the calibration mixture, but 
not so high that it causes space charging in the ion trap. Space charging, caused by too 
many ions in the trap, reduces mass resolution and causes mass shifts.

4. Use the automated calibration procedure to calibrate the mass spectrometer. 

See Chapter 5, “Tuning and Calibrating in the MALDI Mode,” for detailed instructions on 
tuning and calibrating the MALDI LTQ XL system.
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2

Setting Up the Xcalibur Instrument Configuration

To control the MALDI source and the LTQ XL mass spectrometer from the Xcalibur™ data 
system, add these devices to the software configuration using the Xcalibur Instrument 
Configuration program. 

Adding the MALDI LTQ XL to the Xcalibur Instrument Configuration
Because you cannot have the Xcalibur Instrument Configuration program open 
simultaneously with the Xcalibur data system or the Tune Plus program, close Xcalibur and 
the Tune Plus if they are open.

To add the LTQ XL MS and MALDI source to the list of Configured Devices

1. Choose Start > All Programs > Thermo Foundation 1.0 > Instrument Configuration. 

The Thermo Foundation Instrument Configuration dialog box opens (Figure 17 on 
page 28). 

Contents

• Adding the MALDI LTQ XL to the Xcalibur Instrument Configuration 

• Specifying the Ion Source for the LTQ XL MS Detector 

• Viewing or Changing the MALDI Source Configuration Options 

Note  For Xcalibur version 2.0.7 or earlier, the path is Start > All Programs > 
Xcalibur > Instrument Configuration. 
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2 Setting Up the Xcalibur Instrument Configuration
Adding the MALDI LTQ XL to the Xcalibur Instrument Configuration
Figure 17. Thermo Foundation Instrument Configuration dialog box

2. Select the devices that you want to control from the Xcalibur data system:

a. In the Device Types list, select All.

b. In the Available Devices list, double-click LTQ XL MS. 

A copy of the LTQ XL MS button appears in the Configured Devices list (Figure 18 
on page 29).

c. In the Available Devices list, double-click MALDI Source.

A copy of the MALDI Source button appears in the Configured Devices list 
(Figure 18 on page 29).
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 2 Setting Up the Xcalibur Instrument Configuration
Specifying the Ion Source for the LTQ XL MS Detector
Figure 18. Instrument Configuration dialog box with configured devices

Xcalibur now recognizes the LTQ XL mass spectrometer and the MALDI source as 
devices currently in use. 

3. Do not close the Instrument Configuration dialog box. Go to the next topic, “Specifying 
the Ion Source for the LTQ XL MS Detector.” 

Specifying the Ion Source for the LTQ XL MS Detector
Use the Xcalibur Instrument Configuration program to specify the MALDI ion source for the 
LTQ XL mass spectrometer. 

To specify the ion source for the LTQ XL MS detector

1. In the Configured Devices list, double-click the LTQ XL MS icon. 

The LTQ XL Configuration dialog box opens (Figure 19 on page 30). 
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2 Setting Up the Xcalibur Instrument Configuration
Specifying the Ion Source for the LTQ XL MS Detector
Figure 19. LTQ XL Configuration dialog box

2. In the list on the left side of the dialog box, select Ion Source. 

The Default source list is displayed with MALDI chosen by default (Figure 20). 

Figure 20. LTQ XL Configuration dialog box with the Default source list

3. Click OK. 

A message box opens:

In order for the configuration changes to take effect, you will need to reboot the data 
system and then the LTQ.

4. Click OK.

5. Reboot the data system.

For instructions, refer to Chapter 4, “System Shutdown, Startup, and Reset” in the LTQ 
Series Hardware Manual.

6. Reboot the MS detector.
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 2 Setting Up the Xcalibur Instrument Configuration
Viewing or Changing the MALDI Source Configuration Options
For instructions, see “Rebooting the MALDI LTQ XL System” on page 40. 

7. Do one of the following:

• To enter the serial number of the MALDI source, go to the next topic, “Specifying 
the Ion Source for the LTQ XL MS Detector.” 

OR

• To exit the Xcalibur Instrument Configuration program, click Done. See Figure 18 
on page 29.

Viewing or Changing the MALDI Source Configuration Options
You do not need to configure the ion source for operation. However, you can use the MALDI 
Source Configuration dialog box to view the serial number and firmware version for the 
MALDI source, and to change the serial number. 

To view or change a serial number or view the firmware version

1. Choose Start > All Programs > Thermo Foundation 1.0 > Instrument Configuration. 

The Xcalibur Instrument Configuration dialog box opens (Figure 18 on page 29).

2. In the Configured Devices list, double-click the MALDI Source icon.

The MALDI Source Configuration dialog box opens (Figure 21 on page 32).

Note  For Xcalibur version 2.0.7 or earlier, the path is Start > All Programs > 
Xcalibur > Instrument Configuration. 
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2 Setting Up the Xcalibur Instrument Configuration
Viewing or Changing the MALDI Source Configuration Options
Figure 21. MALDI Source Configuration dialog box

The Serial Number box contains the current entry for the serial number, and the 
Firmware Version readback displays the firmware version of the MALDI source. The 
Firmware Version readback displays a value of Unknown until you run the Tune Plus 
MALDI diagnostics tool for the first time.

3. To change the serial number, type a new number in the Serial Number box. 

4. Click OK. 

5. In the Instrument Configuration dialog box (Figure 18 on page 29), click Done. 
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3

Preparing for Daily Operation

To prepare the MALDI LTQ XL system for daily operation, follow these procedures.

Using the Equipment and Materials Checklist
Check that your laboratory has the equipment, consumables, and chemicals shown in Table 2 
on page 34. You must have these items to prepare samples and clean the MALDI sample 
plates. In addition, you must also have the ProteoMass™ MALDI Calibration Kit to prepare 
the calibration and sensitivity samples.

For information on preparing the calibration mixtures, see Appendix A, “ProteoMass 
Calibration Kit.” 

Contents

• Using the Equipment and Materials Checklist

• Checking the Helium and Nitrogen Gas Supplies 

• Checking the LTQ XL System Mode 

• Checking the Helium and Nitrogen Gas Supplies 

• Turning the MALDI Source On 

• Placing the MALDI Source in Standby Mode

• Rebooting the MALDI LTQ XL System 

• Using the Diagnostics 
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3 Preparing for Daily Operation
Using the Equipment and Materials Checklist
Table 2. Equipment and materials checklist

Equipment

Sonicator bath, approved for use in a chemical hood in the presence of flammable 
vapor, large enough to hold a 1 L beaker or a flat tray that can hold the MALDI plate. 
(The tray must be inert to acetonitrile, methanol, and dilute ammonium hydroxide.)

Microcentrifuge

Vortexer

Pipettors (2.5 μL, 200 μL, and 1000 μL recommended; additional sizes might be 
useful.) 

Analytical balance

Consumables 

Microcentrifuge tubes (500 μL and 1.5 mL non siliconized)

Tips for pipettors, non-siliconized

Optical lens wipes or soft, clean room wipes

Can of compressed difluoroethane (sold as “compressed air” for dust removal) or 
ultra high purity nitrogen

Chemicals/Solvents (all LCMS-grade)

Water (Fisher Chemical P/N W6-1)

Isopropyl alcohol (Fisher Chemical P/N A461-4)

Methanol (Fisher Chemical P/N A456-1

Acetonitrile (Fisher Chemical P/N A955-1)

Acetone (Fisher Chemical P/N A929-1)

Trifluoroacetic acid (TFA) (Fisher Chemical P/N A116-50)

28%-30% ammonium hydroxide solution (Fisher Chemical P/N A470-250)
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 3 Preparing for Daily Operation
Checking the Helium and Nitrogen Gas Supplies
Checking the Helium and Nitrogen Gas Supplies
Be sure to check the helium and nitrogen gas supplies before operating the MALDI LTQ XL 
system. The LTQ XL mass spectrometer uses helium as a damping gas and collision activation 
partner in the mass analyzer. When the LTQ XL mass spectrometer is operated in the MALDI 
mode, the MALDI source uses nitrogen gas to maintain a pressure of approximately 75 mTorr 
in the sample chamber.

To check the helium and nitrogen gas supplies

1. Check that the helium and nitrogen lines are properly connected to the back of the 
LTQ XL mass spectrometer.

For information on checking the nitrogen line connection to the MALDI sample 
compartment, contact your Thermo Fisher Scientific field service engineer.

2. Check that gases are flowing and that the pressure for each gas is correct. 

• The helium pressure should be 40 ± 10 psig (275 ± 70 kPa). 

• The nitrogen pressure should be 100 ± 20 psig (690 ± 140 kPa). 

3. Make sure that you have sufficient gas to complete your analysis. If necessary, replace the 
helium or nitrogen tank. 

For more information on gas requirements, go to the LTQ Series Preinstallation 
Requirements Guide. 

Checking the LTQ XL System Mode
When you are not using the MALDI LTQ XL system, place the LTQ XL mass spectrometer 
in Standby mode. When you put the LTQ XL mass spectrometer in Standby mode, the 
electron multipliers, conversion dynode, main RF voltage, and ion guide RF voltages turn off. 
The LTQ XL also turns off the nitrogen gas flow to the MALDI sample module. The System 
LED on the front panel of the LTQ XL mass spectrometer is amber when the system is in 
Standby mode.

Before beginning an analysis, take the LTQ XL mass spectrometer out of Standby mode and 
turn it on. Because the MALDI laser has a limited lifespan, place the MALDI source in the 
Standby mode when it is not in use, even for brief periods. 

To turn the LTQ XL mass spectrometer on

1. On the Windows taskbar, choose Start > All Programs > Thermo Instruments > LTQ > 
model Tune. 

Note  For LTQ version 2.5.0 or earlier, the path is Start > All Programs > Xcalibur > 
model Tune. 
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3 Preparing for Daily Operation
Checking the Vacuum Pressure
The Tune Plus window opens with the status view on the right side of the window 
(Figure 22). 

Figure 22. Tune Plus window

You can determine the state of the MS detector by observing the state of the 
On/Off/Standby button on the Control/Scan Mode toolbar. The three different states of 
the On/Off/Standby button are shown at the left.

2. Click the On/Off/Standby button to turn the LTQ XL mass spectrometer on.

The nitrogen supply to the MALDI source automatically turns on. The System LED on 
the front panel of the LTQ XL mass spectrometer turns green. The high voltage to the 
electron multipliers turns on and the MALDI source goes into Standby mode unless you 
have just rebooted the mass spectrometer by pressing the Reset button on the power entry 
panel of the instrument (see “Rebooting the MALDI LTQ XL System” on page 40). 

Checking the Vacuum Pressure
If the Thermo Fisher Scientific field service engineer has just installed the MALDI source, or 
if you have vented the source to atmosphere recently, allow sufficient time for the ion source 
to reach operating vacuum levels before you use the system.

To check the vacuum pressures

• On the Windows taskbar, choose Start > All Programs > Thermo Instruments > LTQ > 
model Tune. 

On

Off

Standby

Note  For LTQ version 2.5.0 or earlier, the path is Start > All Programs > Xcalibur > 
model Tune. 
36 MALDI Source Getting Started Guide Thermo Scientific



 3 Preparing for Daily Operation
Turning the MALDI Source On
The Tune Plus window opens with the status view on the right side of the window 
(Figure 22 on page 36).

The values for Vacuum OK and Ion Gauge Pressure OK should be Yes. The value for 
Upper Chamber should be approximately 0.08 Torr (70 to 80 mTorr). 

Turning the MALDI Source On
To turn the MALDI source on

1. In Tune Plus, choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page displayed by default 
(Figure 23). 
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3 Preparing for Daily Operation
Turning the MALDI Source On
Figure 23. MALDI Source dialog box

Acquire Data button

MALDI source
On/Off/Standby button
38 MALDI Source Getting Started Guide Thermo Scientific



 3 Preparing for Daily Operation
Placing the MALDI Source in Standby Mode
Two buttons at the bottom of the MALDI Source dialog box show the state of the 
MALDI source, as described in Table 3.

2. Click the MALDI source On/Off/Standby button to turn the MALDI source on. 

The laser starts firing. If the MALDI source has been in Standby mode for more than 
15 minutes, the laser initializes before firing, resulting in a 10 second delay. During this 
delay period, the Standby button flashes on and off and the Acquire Data button is 
unavailable. 

Placing the MALDI Source in Standby Mode
To place the MALDI source in Standby mode

• Click the MALDI source On/Off/Standby button to place the MALDI in Standby 
mode. 

When you are acquiring an Xcalibur raw data file, stopping data acquisition also places 
the MALDI source in Standby mode. 

Table 3. MALDI Source dialog box buttons

Button Name State Description

MALDI Source On

Off

Standby

The MALDI source is on and the laser is firing.

The MALDI source is off because the LTQ XL 
MS detector is off.

The MALDI source is in Standby mode 
because LTQ XL MS detector is on.

Acquire Data On

Off

Standby

The MALDI source is acquiring data.

Data is not being acquired because the LTQ XL 
MS detector is off.

Data acquisition is in Standby mode.

On

Standby

Off

Note  Because the MALDI laser has a limited lifespan, place the MALDI source in 
Standby mode when not in use, even for brief periods. 

On

Standby

Off
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3 Preparing for Daily Operation
Rebooting the MALDI LTQ XL System
The Status view displays the following readback states for the MALDI laser: 

• When the MALDI source has been in Standby mode for more than 15 minutes, the 
status readback displays Off. When the laser is in the Off mode, it must go through an 
initialization process before firing. 

• When the laser is not firing (but has fired shots within the last 15 minutes), the status 
readback displays Standby.

• When the laser is firing, the status readback displays Yes (Figure 24).

Figure 24. Tune Plus window with the Status view showing the laser status

Rebooting the MALDI LTQ XL System
Occasionally, you might need to reboot the LTQ XL mass spectrometer. When you reboot the 
LTQ XL mass spectrometer, the high voltage to the electron multipliers does not turn on until 
you take the LTQ XL mass spectrometer out of Standby mode and turn on the MALDI 
source. 

Laser Status 
readback 
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 3 Preparing for Daily Operation
Using the Diagnostics
To reboot the MALDI LTQ XL system

1. Press the Reset button on the power panel of the LTQ XL mass spectrometer (Figure 25).

Figure 25. LTQ XL power panel 

The instrument goes through an initialization process that you can monitor in the 
LTQ XL console window.

2. In the Tune Plus window, click the On/Standby button to turn the LTQ XL mass 
spectrometer on.

3. In the MALDI Source dialog box, click the MALDI source On/Standby button to turn 
the MALDI source on. 

4. In the MALDI Source dialog box, click the MALDI source On/Standby button again to 
place the MALDI source in Standby mode until you are ready to work with a sample 
plate.

Using the Diagnostics
The Thermo Fisher Scientific field service engineer uses the diagnostics tools during 
installation of your MALDI LTQ XL system. You can also use these tools to check the current 
calibration settings and the sample plate type:

• “Opening the Diagnostics Dialog Box,” next section

• “Viewing or Printing the Currently Saved Calibration Settings” on page 42 

• “Checking or Selecting the Sample Plate Type” on page 44 

• “Adjusting the Video Camera Contrast and Brightness” on page 47 

Power In

Mech. Pumps/Accessory

A 5.5 MAX.

A 5.5 MAX.

Main Power

Peripheral Control

Ethernet

Electronics Normal

Service Mode

Reset

Analog Input

Start
In

100 Base T

Ready
Out

1V MAX 10V MAX

Start
Out

On
V~230 V
Hz 50/60

15 A

Off

Reset button

On

Standby

On

Standby

Off
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3 Preparing for Daily Operation
Using the Diagnostics
Opening the Diagnostics Dialog Box

To open the Diagnostics dialog box 

1. On the Windows taskbar, choose Start > All Programs > Thermo Instruments > LTQ > 
model Tune. 

The Tune Plus window opens (Figure 24 on page 40).

2. Choose Diagnostics > Diagnostics. 

The Diagnostics dialog box opens with the Tools list displayed by default (Figure 26).

Figure 26. Diagnostics dialog box 

Viewing or Printing the Currently Saved Calibration Settings

To view or print the currently saved calibration settings 

1. In the Diagnostics dialog box Tools list, select Display settings. 

The Display settings list opens (Figure 27 on page 43).

Note  For LTQ version 2.5.0 or earlier, the path is Start > All Programs > Xcalibur > 
model Tune. 
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 3 Preparing for Daily Operation
Using the Diagnostics
Figure 27. Display settings list

2. Select the Display calibration settings check box. 

3. Click Start.

The calibration settings appear in the Testing pane. To print the current calibration 
values, click Print. 

The current calibration settings are stored in the MasterLTQ.cal file. You can find this file 
in the following directory:

C:\Xcalibur\system\LTQ\msx
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3 Preparing for Daily Operation
Using the Diagnostics
Checking or Selecting the Sample Plate Type

If the MALDI system cannot locate the identification marks on the sample plate that you 
have loaded into the sample compartment, it defaults to the Thermo 384 Well Plate type. If 
the data system does not recognize the sample plate type that you have loaded into the 
MALDI sample compartment, you can check or specify the sample plate type.

Table 4 lists the identification marks for the various types of Thermo Scientific plates you can 
use with the MALDI source.

To check the sample plate type

1. In the Diagnostics dialog box Tools list, select MALDI.

The MALDI tools appear with the Video Camera Contrast and Brightness test displayed 
by default (Figure 28 on page 45).

Table 4. Sample plate identification mark

Plate type Identification mark

96-well plate Four squares in a plus sign arrangement

384-well plate Five squares in an X arrangement 

General purpose blank plate Open square
Note: This plate was released after LTQ 
version 2.5.

Adapter plate for stainless steel 
slides (tissue imaging)

Capital T

Adapter plate for glass slides 
(tissue imaging)

Capital I
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 3 Preparing for Daily Operation
Using the Diagnostics
Figure 28. Video Camera Contrast and Brightness test

2. From the Test Name list, select Sample Plate Type Determination.

The Sample Plate Type Determination test is displayed (Figure 29 on page 46).
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3 Preparing for Daily Operation
Using the Diagnostics
Figure 29. Sample Plate Type Determination test

3. Select the AutoConfig Plate Type check box.

4. Click Start.

5. If the camera cannot locate the plate identification marks, do one of the following:

• Increase the video camera contrast and brightness as described in the next procedure, 
“Adjusting the Video Camera Contrast and Brightness.” 

OR

• Select the check box that corresponds to the plate type you have inserted into the 
MALDI sample module, and then click Start.
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 3 Preparing for Daily Operation
Using the Diagnostics
Adjusting the Video Camera Contrast and Brightness

If the sample plate looks too dark or blurry in the image view of the MALDI source dialog 
box, or if the camera cannot locate the plate identification marks on the plate, try adjusting 
the video camera contrast and brightness.

To adjust the video camera contrast and brightness

1. In the Diagnostics dialog box Tools list, select MALDI.

The MALDI tests appear with the Video Camera Contrast and Brightness test displayed 
by default (Figure 28 on page 45).

2. Increase the brightness by approximately 20%. 

3. Click OK. 

4. Repeat step 2 and step 3.

5. If the camera cannot locate the plate identification marks after you increase the video 
brightness, remove the plate from the system and clean it.

For more information on the MALDI Diagnostics, refer to the MALDI Source Hardware 
Manual.

Note  Clicking the Reset button restores the factory default values for brightness and 
contrast.
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4

Working with Sample Plates

These procedures describe how to clean a sample plate before you spot it, and how to load the 
sample plate into and remove the sample plate from the MALDI sample module.

Preparing the Sample Plate
For accurate analyses, you must clean the sample plate before you spot it with the calibration 
mixtures, the sensitivity test solutions, or your samples.

To prepare the sample plate, perform the following procedures:

• “Disassembling the Sample Plate,” next section

• “Cleaning the Top Plate of the Sample Plate” on page 50 

• “Assembling the Sample Plate” on page 55 

Contents

• Preparing the Sample Plate 

• Loading a Sample Plate into the MALDI Sample Module 

• Removing a Sample Plate from the MALDI Sample Module 
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4 Working with Sample Plates
Preparing the Sample Plate
Disassembling the Sample Plate

The MALDI sample plate consists of two parts: a top plate, which is engraved in either a 
96-well or 384-well format, and a base plate, where the top plate is mounted. You only need 
to clean the top plate. 

To remove the top plate from the base plate

1. Wearing gloves, hold the sample plate upside down. Grasp the top plate by the edges, 
being careful not to touch its surface.

2. Pull the latch on the back of the base plate in the direction of the arrow to disengage the 
top plate from the base plate. 

3. Pull the top plate away from the base plate. 

Cleaning the Top Plate of the Sample Plate

Before you prepare the calibration mixture and spot it on the sample plate, clean the surface of 
the sample plate to remove contaminants and ensure a good surface for sample deposition.

Thermo Fisher Scientific recommends the following procedures to clean the surface of the 
sample plate:

• “Routine Cleaning,” next section

• “Deep Cleaning” on page 53 

If the routine cleaning procedure does not remove the surface contamination, try the deep 
cleaning procedure.

IMPORTANT  When handling a sample plate, ensure that you do not scratch the plate 
surface. Hold the sample plate by the edges. Never touch the plate surface, even when 
wearing gloves.

CAUTION  Use only sample plates designed or certified by Thermo Fisher Scientific for 
use with the MALDI source; otherwise, you can severely damage the source. 
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 4 Working with Sample Plates
Preparing the Sample Plate
Routine Cleaning

Before beginning the routine cleaning procedure, make sure you have the following items:

• Soft wipes (optical lens wipes or soft, clean room wipes are recommended to avoid 
scratching the plate surface) 

• Compressed difluoroethane (sold as compressed air for removing dust) or ultra 
high-purity nitrogen

• Sonicator (ultrasonic cleaner) 

This procedure also requires the following solvents, which must be LCMS grade:

• LCMS-grade acetonitrile (Fisher Chemical P/N A955-4)

• LCMS-grade methanol (Fisher Chemical P/N A456-1)

• 18 MΩ-cm deionized water or LCMS-grade water (Fisher Chemical P/N W6-1)

IMPORTANT  It is best to use gas from an oil-free compressed gas system. Gas from an 
aerosol canister can contaminate the plate with propellant (liquid difluoromethane). 
If you must use gas from an aerosol canister, be sure to prevent the propellant from 
contaminating the plate surface. If you contaminate the plate with propellant, you 
must clean it again. Take the following precautions to avoid getting the propellant on 
the sample plate:

• Do not shake the compressed gas canister.

• Keep the canister upright when spraying.

• Spray in a series of short bursts rather than in a single continuous stream.

• When the canister is close to being empty, replace it with a fresh one.

CAUTION  The sonicator (ultrasonic cleaner) must be approved for use with 
flammable vapors. Perform the sonication in a chemical fume hood.

CAUTION  This procedure uses chemicals that are toxic and volatile. Wear gloves, work in 
a fume hood, and take other appropriate precautions while cleaning the sample plate.

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear safety glasses when you use solvents or corrosives. Refer to your supplier's 
Material Safety Data Sheet (MSDS) for the proper handling of a particular solvent or 
compound. 
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4 Working with Sample Plates
Preparing the Sample Plate
To clean the sample plate using the routine cleaning procedure

1. Sequentially rinse the plate with the following solvents and use a soft wipe to wipe the 
surface of the plate dry between each solvent rinse: 

a. Acetonitrile

b. Methanol

c. Water

2. Place the plate in a 1000-mL beaker or similar container. The beaker or container must be 
inert to acetonitrile.

3. Add enough acetonitrile to cover the entire plate. 

4. Cover the beaker with aluminum foil, place it in the sonicator, and sonicate for 
5 minutes.

5. Replace the acetonitrile with methanol and sonicate for 5 minutes.

6. Replace the methanol with water and sonicate for 5 minutes. 

7. Remove the plate from the beaker. 

8. Dry the plate completely with ultra high-purity compressed air or ultra high-purity 
nitrogen. 

9. Store the plate under vacuum for a few hours to ensure complete dryness. 

Storing the plate under vacuum is especially important when spotting calibration 
samples, since the high organic content of the calibration mix can cause it to spread if the 
plate is not completely dry.

CAUTION  The sonicator (ultrasonic cleaner) must be approved for use with 
flammable vapors. Perform the sonication in a chemical fume hood.
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 4 Working with Sample Plates
Preparing the Sample Plate
Deep Cleaning

Before beginning the deep cleaning procedure, make sure that you have the following items:

• Sonicator

• Soft wipes (optical lens wipes or soft, clean room wipes to avoid scratching the plate 
surface

• Ultra high-purity nitrogen or compressed air in a canister, sold as compressed air for 
removing dust 

You must use the following solvents (LCMS grade) with this procedure:

• Isopropyl alcohol (Fisher Chemical P/N A461-4)

• Acetonitrile (Fisher Chemical P/N A955-4)

• Methanol (Fisher Chemical P/N A456-1)

• Water (Fisher Chemical P/N W6-1)

• 30% ammonium hydroxide solution (Fisher Chemical P/N A470-250)

Vapors from a solution of 30% ammonium hydroxide can irritate the respiratory tract 
and eyes. Skin contact with this solution can cause burns.

CAUTION  The sonicator (ultrasonic cleaner) must be approved for use with 
flammable vapors. Perform the sonication in a chemical fume hood.

IMPORTANT  It is best to use gas from an oil-free compressed gas system. Gas from an 
aerosol canister can contaminate the plate with propellant (liquid difluoromethane). 
If you must use gas from an aerosol canister, be sure to prevent the propellant from 
contaminating the plate surface. If you contaminate the plate with propellant, you 
must clean it again. Take the following precautions to avoid getting the propellant on 
the sample plate:

• Do not shake the compressed gas canister.

• Keep the canister upright when spraying.

• Spray in a series of short bursts rather than in a single continuous stream.

• When the canister is close to being empty, replace it with a fresh one.

CAUTION  This procedure uses chemicals that are toxic, corrosive, and/or volatile. Wear 
gloves, work in a fume hood, and take other appropriate precautions while cleaning the 
sample plate.
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4 Working with Sample Plates
Preparing the Sample Plate
To clean the sample plate using the deep cleaning procedure 

1. Prepare a 3% ammonium hydroxide/acetonitrile cleaning solution by mixing 450 mL of 
acetonitrile, 450 mL of water, and 100 mL of 30% ammonium hydroxide. Mix the 
solution well. 

You can prepare this solution in advance and store it in a glass container with a securely 
fitted screw cap.

2. Using isopropyl alcohol and a soft wipe, wet the plate surface and gently wipe it. Repeat 
this step several times. 

3. Rinse the plate surface with methanol. 

4. Place the plate in a 1000 mL beaker or other suitable container, and add the cleaning 
solution prepared in step 1 until the plate is covered. 

5. Place the beaker in a sonicator. Cover the beaker with aluminum foil to prevent 
evaporation of the cleaning solution. 

6. Sonicate a fully immersed plate for 5 minutes. 

7. Using forceps, remove the plate from the cleaning solution, and place it in another 
container. Rinse several times with water to remove the cleaning solution. 

8. Rinse the plate thoroughly with methanol. 

9. Rinse the plate thoroughly with water.

10. Dry the plate completely with ultra high-purity compressed air or ultra high-purity 
nitrogen. 

11. Store the plate under vacuum for a few hours to ensure complete dryness. 

Drying the plate under vacuum is especially important when spotting calibration samples 
since the high organic content of the calibration mix can cause it to spread if the plate is 
not completely dry.

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear safety glasses when you use solvents or corrosives. Refer to your supplier's 
Material Safety Data Sheet (MSDS) for the proper handling of a particular solvent or 
compound. 

CAUTION  The sonicator (ultrasonic cleaner) must be approved for use with 
flammable vapors. Perform the sonication in a chemical fume hood.
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Preparing the Sample Plate
Assembling the Sample Plate

To reassemble the clean sample plate

1. Hold the base plate upside down. 

2. Pull the latch on the back of the base plate in the direction of the arrow. 

3. Fit the top plate snugly to the surface of the base plate. There must be no space between 
the top plate and the base plate (Figure 30).

Figure 30. Sample plate assembly

4. Release the latch on the back of the plate. Do not touch the surface of the wells.

5. (Optional) Place an identifying label on the plate with a marker pen. Do not tape 
anything to the sample plate.

Top plate

Base plate Latch

Pull the latch under the plate
to fit the top plate. 

Fit the top plate snugly to the surface of the base plate. 

CAUTION  The top plate must fit snugly to the base plate. Loading a misaligned plate 
assembly into the MALDI sample module can damage the MALDI source.

CAUTION  Do not tape anything to the sample plate. Loading sample plates with 
taped objects into the MALDI sample module can damage the MALDI source.
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Loading a Sample Plate into the MALDI Sample Module
Always use sample plates approved by Thermo Fisher Scientific. Make sure that you have 
assembled the sample plate correctly and have not taped anything to the plate before you load 
the plate into the MALDI sample module. A grinding noise coming from the MALDI sample 
module usually indicates that a sample plate is jammed somewhere in the XYZ mechanism. If 
this situation occurs, turn off the power to the LTQ XL mass spectrometer and contact 
Thermo Fisher Scientific Technical Support.

To load the sample plate into the MALDI sample module

1. If LTQ Tune is not running, on the Windows taskbar, choose Start > All Programs > 
Xcalibur > LTQ Tune.

The Tune Plus window opens (Figure 22 on page 36).

2. If there is currently a sample plate loaded in the MALDI source, remove it before 
proceeding. See “Removing a Sample Plate from the MALDI Sample Module” on 
page 59.

3. Make sure that there is no gap between the top plate and the base plate and that nothing 
is taped to the sample plate.

4. Insert the sample plate into the loading slot in the front of the MALDI sample module. 
The slot accepts the plate in one orientation only. Ensure that the top edge of the plate 
with the row of numbers engraved on it faces outward. See Figure 31. 

CAUTION  If you hear a grinding noise coming from the MALDI sample module and you 
suspect that a sample plate is jammed somewhere in the XYZ mechanism, turn off the 
power to the LTQ XL mass spectrometer.

CAUTION  Inserting a misaligned sample plate assembly or a sample plate assembly 
with anything extra attached to it, such as a piece of tape, can damage the MALDI 
source.
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Figure 31. Schematic of MALDI sample plate with arrows showing the orientation of plate 
loading

5. In the Tune Plus window, choose Setup > MALDI Source. 

The MALDI Source dialog box opens with the Control page shown by default (Figure 32 
on page 58).
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Loading a Sample Plate into the MALDI Sample Module
Figure 32. MALDI Source dialog box

6. Click the Insert Plate button.

The Instrument Messages message box opens and displays a series of messages indicating 
the progress of the plate. The plate insertion process takes approximately two minutes to 
complete.

When the MALDI source completes the plate insertion process, a final message appears:

Do you want to keep the current plate history for the inserted sample plate?
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7. Do one of the following:

• If you want to keep the current plate history, click Yes. The Open dialog box opens. 
Select the appropriate file (*.MALDIPlate) and click Open.

• If you do not want to keep the current plate history, click No.

When the MALDI source completes the insertion process, the Instrument Messages 
dialog box displays another message:

Successfully inserted and calibrated MALDI sample plate. The plate is now ready to 
use.

8. Click Close. 

Removing a Sample Plate from the MALDI Sample Module
To remove the sample plate from the MALDI sample module

1. If LTQ Tune is not running, on the Windows taskbar, choose Start > All Programs > 
Thermo Instruments > LTQ > model Tune. 

The Tune window opens (Figure 22 on page 36).

2. Choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control tab displayed by default 
(Figure 32 on page 58). 

3. If the MALDI source is not in Standby mode, click the On/Standby button. 

The MALDI source must be in Standby mode for the buttons at the top of the tab to be 
available.

4. Click the Eject Plate button.

A message box opens:

Modifications of the current plate have not been saved. Do you want to save a history 
file of the current plate?

5. Do one of the following:

• To save a history file, click Yes. The Save As dialog box opens. Save the file with an 
appropriate name.

• To eject the plate without saving a history file, click No.

• To stop the plate ejection process, click Cancel.

Note  For LTQ version 2.5.0 or earlier, the path is Start > All Programs > Xcalibur > 
model Tune. 

On

Standby
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Removing a Sample Plate from the MALDI Sample Module
The Instrument Messages message box opens and displays a series of messages indicating 
the progress of the plate. The plate ejection process takes approximately two to three 
minutes to complete.

When the ejection process is complete, a final message appears:

Successfully ejected MALDI sample plate. Please take the plate.

6. Click Close.

7. Remove the plate.
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5

Tuning and Calibrating in the MALDI Mode

This chapter describes how to tune, calibrate, and test the sensitivity of the MALDI LTQ XL 
system. 

To tune and calibrate the MALDI LTQ XL system, perform these tasks:

1. Spot the calibrant/matrix mixtures on a plate that has been freshly cleaned for calibration. 

For information on preparing the calibration and sensitivity test targets, see the 
instructions sheet supplied in the Proteomass Calibration Kit or Appendix A, 
“ProteoMass Calibration Kit.”  

2. Load the spotted calibration plate into the MALDI sample module.

For information on loading the sample plate, see “Loading a Sample Plate into the 
MALDI Sample Module” on page 56.

3. Tune the laser energy to optimize ionization as described in “Tuning the Laser Energy 
with the Semi-Automatic Function” on page 73.

4. Obtain a quick spectrum of the calibration mix to ensure that you can observe all of the 
peptides. 

5. With the tune file that contains the optimized laser energy open in the Tune Plus window, 
calibrate the mass spectrometer as described in “Calibrating the Mass Spectrometer” on 
page 79. 

IMPORTANT  These procedures use specially prepared calibrant/matrix mixtures. Before 
you spot the sample plate with the calibrant/matrix mixtures, ensure that the sample plate 
is clean and dry. To ensure dryness, store the sample plate under vacuum in the MALDI 
sample module until you are ready to spot the plate with the calibrant/matrix mixtures.

Contents

• Tuning on an Analyte

• Calibrating the Mass Spectrometer 

• Checking the Sensitivity of the MALDI LTQ XL System

• Checking the Calibration 
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Use the Check page of the Calibrate dialog box to check the calibration on your mass 
spectrometer once a month, and recalibrate if it does not pass the calibration check tests or if 
you notice a decrease in mass accuracy.

Tuning on an Analyte
This topic describes how to create a tune file for your analyte of interest. For the tuning and 
calibration procedure, the analyte of interest is the calibrant/matrix mixture prepared by 
following the procedure in “Preparing the Mass Calibration Targets” on page 183.

To create a tune file, follow these procedures:

• “Setting the LTQ XL Parameters for Tuning,” next section

• “Setting the MALDI Source Parameters for Tuning” on page 66 

• “Viewing Mass Spectra in the Tune Plus Window” on page 71 

• “Tuning the Laser Energy with the Semi-Automatic Function” on page 73 or “Adjusting 
the Laser Energy Manually” on page 76 

Table 5 lists the parameters stored in a MALDI tune file.

Table 5. Parameters stored in a tune file  (Sheet 1 of 2)

Parameter Description

Optimal laser 
energy for a mass 
range

The laser energy focused on a target spot determines the number of 
ions that enter the ion trap. A laser energy that is too low causes a poor 
signal-to-noise ratio for the ions of interest. A laser energy that is too 
high can cause space charging. Space charging, which is caused by too 
many ions in the ion trap, can result in poor mass resolution and mass 
shifts.

Use the Setup page in the MALDI Source dialog box to set the laser 
energy.

AGC setting (On 
or Off ), including 
the number of 
laser shots with 
AGC Off

• With the AGC On option selected, the MALDI source uses a 
prescan to determine the number of laser shots per microscan. 

• With the AGC Off option selected, you manually set the number 
of laser shots. 

Use the Setup page in the MALDI Source dialog box to select the AGC 
On or Off option.
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Setting the LTQ XL Parameters for Tuning 

To set the LTQ XL mass spectrometer parameters for tuning and calibration 

1. On the Windows taskbar, choose Start > All Programs > Thermo Instruments > LTQ > 
model Tune. 

The Tune Plus window opens (Figure 22 on page 36). 

2. On the Control/Scan Mode toolbar, click the On/Standby button to turn the LTQ XL 
mass spectrometer on.

3. On the File/Display toolbar, click the Open button.

4. Browse to the following folder:

C:\Xcalibur\methods

5. Select the Default_MALDI.LTQtune file or a tune file with an appropriate laser energy 
setting for the calibrant/matrix mixture. 

6. Click Open. 

Number of 
microscans

A microscan is one mass analysis (ion injection and storage/scan out of 
ions followed by ion detection). Microscans are summed to produce 
one analytical scan. Summing microscans improves the signal-to-noise 
ratio of the mass spectral data. Increasing the number of microscans 
increases the time required to perform each scan.

Use the Define Scan dialog box to set the number of microscans. Set 
the number of microscans in the Define Scan dialog box to a multiple 
of the microscans/step setting (enabled when ASF is set to Off ) in the 
MALDI Source dialog box.

Number of sweep 
shots

The plate history file contains information about each sample spot, 
including a record of the fine positions within a sample spot that have 
been fired on by the laser. If the laser has not previously fired on a spot, 
the laser fires the specified number of sweep shots to remove 
contaminants from a spot. A sweep shot carries the same energy as a 
standard laser shot. 

Use the Setup page in the MALDI Source dialog box to set the number 
of sweep shots.

Table 5. Parameters stored in a tune file  (Sheet 2 of 2)

Parameter Description

Note  For LTQ version 2.5.0 or earlier, the path is Start > All Programs > Xcalibur > 
model Tune. 

On

Standby
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7. On the Control/Scan Mode toolbar, ensure that the data type is set to Profile. 

Because Profile data type retains resolution information, use this data type for MALDI. In 
Profile mode, the peak has an area and a width. In centroid mode, the whole peak area is 
contained in a spike. Internal calculations by the program use centroid peaks regardless of 
the acquisition mode selected.

8. Click the Positive/Negative button to switch the ion polarity mode to positive. 

9. Specify the scan parameters for the LTQ XL mass spectrometer:

Ensure that the advanced settings are turned on by choosing Scan Mode from the menu 
bar.

If the Advanced Scan Mode command in the Scan Mode menu has a check mark in front 
of it, the advanced settings are turned on. If not, choose Advanced Scan Mode to turn on 
the advanced settings. 

10. On the Control/Scan Mode toolbar, click the Define Scan button.

The Define Scan dialog box opens (Figure 33). 

Figure 33. Define Scan dialog box

11. Set the parameters in the Define Scan dialog box. With the exception of the settings 
shown in Table 6, use the default settings. Figure 34 on page 65 shows the settings for 
viewing the mass spectrum of the Normal Mass Range Calibration Mix.

Profile

Centroid

Positive
Polarity

Negative
Polarity
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Figure 34. Define Scan dialog box with settings for MALDI tuning and calibration

12. Click OK. 

Next, set the MALDI source parameters as described in “Setting the MALDI Source 
Parameters for Tuning,” next. 

Table 6. MALDI-specific Define Scan settings 

Area Parameter Setting

Scan Description Mass Range Normal

Scan Rate Normal

Scan Type Full

Scan Time Microscans 2

Scan Ranges First Mass (m/z) 500.00

Last Mass (m/z) 2000.00
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Setting the MALDI Source Parameters for Tuning

With modifications, you can use the following procedure to tune on your analyte of interest. 
The analyte of interest for tuning and calibration is either the Normal Mass Calibration 
Mix/matrix mixture or the High Mass Calibration Mix/matrix mixture. Because the 
calibrant/matrix mixture contains a high concentration of each of the calibration peptides, the 
Automatic Gain Control (AGC) feature, which automatically determines the number of laser 
shots required for a target spot, is not used. AGC is a useful feature for low concentration 
samples.

To set the MALDI source parameter to tune on the calibrant/matrix mixture

1. In the Tune Plus window, choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page shown by default (Figure 35 
on page 67). 
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Figure 35. MALDI Source dialog box

2. For the calibrant/matrix mixture, use the settings in Table 7. 

Table 7. Control page settings for MALDI calibrant/matrix mixture (Sheet 1 of 2)

Area Parameter Setting

MALDI Settings Plate Motion CPS

ASF Off

Microscans per step 2
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Figure 36 on page 69 shows the Control page settings for tuning on the calibrant/matrix 
mixture. 

Laser Settings Laser Energy Current setting

AGC Off

Num Laser Shot 3

Note  Microscans per step are the number of microscans acquired at one crystal 
location before moving to a fresh MALDI crystal.

IMPORTANT  For best results when creating tune files for low concentration samples 
in the attomole (10-18) to femtomole (10-15) range, select the On option for AGC. 
For best results when creating tune files for samples in the picomole (10-12) to 
nanomole (10-9) range, select the Off option for AGC and manually set the number 
of laser shots.

IMPORTANT  Use laser sweep shots to remove contaminants from the target spots. 
Contaminants rise to the surface of target spots prepared with 
alpha-cyano-4-hydroxycinnamic acid (CHCA), the matrix used to prepare the 
calibrant/matrix mixtures.

Table 7. Control page settings for MALDI calibrant/matrix mixture (Sheet 2 of 2)

Area Parameter Setting
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Figure 36. Control page settings for the calibrant/matrix mixture

3. Click the Setup tab.

The Setup page opens (Figure 37 on page 70).
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Figure 37. Setup page

4. In the Laser Settings area, set the Number Sweep Laser Shot to 5. 

You use the number of sweep laser shots to remove surface contaminants from target spots 
prepared with CHCA. The laser energy setting for your MALDI LTQ XL system might 
differ.

5. Click Apply. 
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Viewing Mass Spectra in the Tune Plus Window

Before you tune on an analyte or calibrate the mass spectrometer, view the mass spectrum of a 
test spot. 

The following procedure describes how to view the mass spectrum of the Normal Mass 
Calibration Mix/matrix mixture. For information on preparing samples for MALDI analysis, 
see Appendix B, “Sample Preparation.”  Adjust the LTQ XL and MALDI source parameters 
for your sample/matrix mixtures. 

To view a mass spectrum in the Tune Plus window

1. Prepare the Normal Mass Calibration Mix/matrix mixture and spot the target plate as 
described in “Preparing the Mass Calibration Targets” on page 183. 

2. Load the plate into the MALDI sample module as described in “Loading a Sample Plate 
into the MALDI Sample Module” on page 56.

3. Set the LTQ XL parameters as described in “Setting the LTQ XL Parameters for Tuning” 
on page 63. 

Adjust the parameters for your analyte.

4. Set the MALDI source parameters as described in “Setting the MALDI Source Parameters 
for Tuning” on page 66.

Adjust the parameters for your analyte.

5. In the MALDI Source dialog box, select a spot on the target plate that has a homogeneous 
coating of the calibrant/matrix. To select a target spot, click a sample spot on the sample 
position map. 

When you click a sample spot on the position map, the spot turns red. The sample plate 
moves so that the laser is positioned to fire at the selected sample spot, and the spot turns 
green.

6. In the MALDI Source dialog box, click the MALDI Source On/Standby button to turn 
the MALDI source on. 

The laser begins firing and the LTQ XL mass spectrometer begins scanning. The laser 
takes approximately 15 seconds to begin firing after the MALDI source has been in 
Standby mode for more than 15 minutes.
 

7. Position the Control page so that you can observe it and the Tune Plus window 
simultaneously. 

8. On the File/Display toolbar in the Tune Plus window, click the Display Spectrum View 
button to open the Spectrum view. 

9. Monitor the spectrum for the masses of interest. 

On

Standby
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When the MALDI LTQ XL system is mass analyzing the Normal Mass Range 
Calibration Mix/matrix mixture, look for a mass spectrum consisting of the singly 
charged ions listed in Table 8.

Figure 38 shows the mass spectrum of the Normal Mass Calibration Mix.

Figure 38. Mass spectrum of the Normal Mass Calibration Mix

Table 8. Monoisotopic masses of the six peptides in the Normal Mass Range Calibration Mix

Peptide (M+H)+ Monoisotopic mass 

MRFA 524.27 

Bradykinin 1-7 757.40 

Bradykinin 1060.57 

Angiotensin I 1296.69 

Neurotensin 1672.92 

Renin substrate 1758.93 

MRFA Bradykinin 1-7

Bradykinin

Angiotensin I

Neurotensin

Renin substrate
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Tuning the Laser Energy with the Semi-Automatic Function

The laser energy is the most important parameter to tune with your MALDI source. Properly 
tuned laser energy is essential for obtaining high quality spectra. You do not need to tune the 
ion optics parameters, such as the multipole offset voltages and lens voltages. 

Optimize the laser energy with the analyte of interest and save the value in a tune file. For the 
Normal Mass Calibration procedure, create a tune file by tuning on the normal mass range 
calibration mix/matrix mixture. For the High Mass Calibration procedure, create a tune file 
by tuning on the high mass calibration mix/matrix mixture. The optimum laser energy for 
these two samples differs by a few microJoules.

Before you start the automated tune procedure, you must set the LTQ XL mass spectrometer 
scan parameters, as described in “Setting the LTQ XL Parameters for Tuning” on page 63. 
During the semi-automatic laser energy optimization procedure, the MALDI application 
automatically sets the MALDI source parameters.

To tune the laser energy

1. Select a sample spot and view the mass spectrum as described in the previous topic, 
“Viewing Mass Spectra in the Tune Plus Window.” 

2. In the Tune Plus window, choose Control > Tune.

The Tune dialog box opens with the Automatic page shown by default (Figure 39).

Figure 39. Tune dialog box
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3. Click the Semi-Automatic tab. 

The Semi-Automatic page opens (Figure 40).

Figure 40. Semi-Automatic page

4. Click Start. 

5. Observe the Tune Plus window and the Tune dialog box. 

While the tuning procedure is in progress, the Spectrum and Graph views display various 
tests and the Status box in the Tune dialog box displays status messages. 

When the system determines the optimal laser energy for the target sample, the Accept 
Optimized Value dialog box appears (Figure 41 on page 75).
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Figure 41. Accept Optimized Value dialog box with the new laser energy value

6. Click Accept.

7. Save your tune method:

8. On the File/Display toolbar, click the Open button.

The Save As dialog box opens.

9. Browse to the following folder:

C:\Xcalibur\methods

10. In the File name box, type a descriptive name for the file, such as MALDIMyCalTune or 
the date so that you can keep track of laser energy and conditions used on a specific day. 

11. Click Save.

The File Summary Information dialog box opens (Figure 42 on page 76).

Note  When the laser energy setting is optimized, the spectrum view displays all ions 
with a resolved isotopic pattern. The monoisotopic masses are within 0.15 to 0.20 u 
of the theoretical m/z for a particular peak (unless the mass calibration has shifted) 
and the signal-to-noise level for the mass peaks is reasonable. See Figure 38 on 
page 72.
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Figure 42. File Summary Information dialog box 

12. In the Description box, type a description for the tune file.

13. Click OK.

The accepted laser energy value is stored in the saved tune file.

Adjusting the Laser Energy Manually

Correct adjustment of the laser energy is essential to obtain the best possible spectra with the 
MALDI source. If the laser energy is set too low, below the MALDI threshold, the laser 
desorbs primarily neutral molecules rather than ions, resulting in a low signal or no signal. 
When the threshold level for ionization is achieved, analyte ions appear in the spectrum in 
quantities that increase with increasing laser energy. If the laser energy is set too high, the laser 
desorbs too many ions from the sample plate, including multiple clusters. This leads to a high 
baseline, high chemical noise, and space charge effects. These in turn cause shifts in m/z that 
affect mass accuracy and reduce resolution. In addition, the higher the laser energy, the faster 
the consumption of sample. If you want to conserve sample, use the lowest laser energy setting 
that still gives good spectra.

The following procedures describe how to manually adjust the laser energy for the Normal 
Mass Calibration Mix/matrix mixture.

To adjust the laser energy manually

1. View the mass spectrum of the Normal Mass Calibration Mix/matrix mixture as 
described in “Viewing Mass Spectra in the Tune Plus Window” on page 71.

2. Monitor the spectrum for the masses of interest. 

When the MALDI LTQ XL system is mass analyzing the Normal Mass Range 
Calibration Mix, look for a mass spectrum consisting of the singly charged ions listed in 
Table 8 on page 72. 
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3. On the Control page of the MALDI Source dialog box, adjust the value in the Laser 
Energy (μJ) box to improve the signal according to guidelines in Table 9.

Make initial adjustments in increments or decrements of five, and then make finer 
adjustments in smaller increments. 

If your signal is weak or noisy, make sure that the calibration sample is fresh. If the calibration 
sample is fresh and you cannot improve the signal by adjusting the laser energy, try another 
sample spot. 

If the signal is too high, even when the laser energy is low, follow these steps to fix the 
problem.

To fix a signal that is too strong when the laser energy is low

1. Reduce the number of laser shots per spectrum: 

a. Choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page shown by default 
(Figure 32 on page 58).

b. In the Laser Settings area, ensure that AGC is set to Off. If it is not, select the Off 
option now.

c. In the Laser Settings area, select a smaller value in the Num Laser Shot box, or type a 
new number. 

2. If the signal is too strong, even with a single laser shot per spectrum, attenuate the ion 
beam by adjusting the front lens voltage:

a. Choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page shown by default 
(Figure 32 on page 58).

b. In the Laser Settings area, ensure that AGC is set to Off. If it is not, select the Off 
option now.

Table 9. Guidelines for MALDI laser power adjustment

Problem Solution

No signal Increase laser energy.

Low signal Increase laser energy.

High baseline Decrease laser energy.

High signal, low baseline, and poor mass 
resolution

Decrease laser energy in small 
increments.

High chemical noise Decrease laser energy.

Peak broadening and shifting to higher mass 
values (space charge effects)

Decrease laser energy.
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c. Choose Setup > Ion Optics.

The Ion Optics dialog box opens (Figure 43).

Figure 43. Ion Optics dialog box

d. Decrease the value in the Front Lens (V) box by 1 to 2 V to increase the negative 
voltage.

e. Click Apply.

f. Observe the spectrum, and if necessary, make additional adjustments to the Front 
Lens voltage. 

g. Click OK.

If you are not able to resolve the signal problems by taking these steps, consult the MALDI 
Source Hardware Manual for more information on diagnostics and troubleshooting. 
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Calibrating the Mass Spectrometer
Calibrating the mass spectrometer ensures that the mass assignments and the number of ions 
in the ion trap are correct. The semi-automatic calibration procedure calibrates all of the 
calibration parameters, such as the multipole RF frequency and the electron multiplier gain. 

If you want to calibrate the mass spectrometer in the high mass range, calibrate the normal 
mass range first, and then calibrate the high mass range. 

To calibrate the mass spectrometer, follow these procedures as necessary:

• “Calibrating the Normal Mass Range,” next section

• “Recalibrating a Failed Item” on page 82 

• “Calibrating the High Mass Range” on page 82 

Calibrating the Normal Mass Range

To calibrate the normal mass range of the mass spectrometer automatically 

1. If you have not already done so, optimize the laser energy for the normal mass calibration 
sample (see “Tuning the Laser Energy with the Semi-Automatic Function” on page 73).

2. In the Tune Plus window, ensure that a tune file with an appropriate laser energy is open. 
The title bar displays the current tune file.

3. View the mass spectrum of the Normal Mass Calibration Mix/matrix mixture (see 
“Viewing Mass Spectra in the Tune Plus Window” on page 71).

4. When you observe a stable mass spectrum, click the Calibrate button. 

The Calibrate dialog box opens with the Automatic page shown by default (Figure 44 on 
page 80). 
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Figure 44. Calibrate dialog box

5. Click the Semi-Automatic tab.

The Semi-Automatic page opens (Figure 45 on page 81).
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Figure 45. Semi-Automatic page 

6. For Mass Range, select the Normal option.

7. To select all items for calibration, select the Select All check box.

8. To start the semi-automatic calibration procedure, click Start. 

The program automatically downloads the appropriate scan settings for the normal mass 
range to the mass spectrometer, and the mass spectrometer uses the laser energy specified 
in the current tune file.

9. Observe the Tune Plus window and the Calibrate dialog box. 

While calibration is in progress, the Spectrum and Graph views display a variety of test 
results, and the Status box of the Calibrate dialog box displays status messages. 

The calibration procedure takes approximately 30 minutes to complete. 
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When the calibration procedure finishes, the Instrument Messages dialog box appears and 
indicates whether the calibration for each item was successful. If the calibration for an 
item is successful, the mass spectrometer saves the new calibration parameter 
automatically to the master calibration file on the hard disk.

10. If the calibration for a particular item fails, try recalibrating on that item individually as 
described in the next topic, “Recalibrating a Failed Item.”  Before recalibrating, check the 
spectrum again to make sure that all ions in the calibration mix are present with adequate 
signal-to-noise ratios.

Recalibrating a Failed Item

To recalibrate a failed item 

1. In the MALDI Source dialog box, on the Control page, select a new spot as necessary.

2. In the What to Calibrate list, select only the check box next to the item you want to 
recalibrate. 

3. Click Start to recalibrate the selected parameters. 

4. Repeat step 1 to step 3 until all calibration items have passed. 

When all calibration items are successful, your mass spectrometer is properly calibrated in the 
normal mass range. 

Calibrating the High Mass Range

Before you operate the mass spectrometer in the high mass range (up to 4000 u), calibrate the 
mass spectrometer in the high mass range. 

To calibrate the high mass range of the mass spectrometer 

1. Prepare the High Mass Calibration Mix/matrix mixture and spot the target plate (see 
“Preparing the Mass Calibration Targets” on page 183). 

2. Load the plate into the MALDI sample module (see “Loading a Sample Plate into the 
MALDI Sample Module” on page 56).

3. Open a tune file with an appropriate laser energy, or optimize the laser energy for the high 
mass calibration sample (see “Tuning the Laser Energy with the Semi-Automatic 
Function” on page 73).

Note  When you operate the MALDI LTQ XL system in the high mass range, you might 
observe artifact peaks. These peaks are produced when some ions of a particular m/z are 
held in the ion trap and ejected later. This produces an artifact peak at a higher m/z value 
than the true m/z value of the ions. When seen, these artifact peaks are typically present at 
low intensities and cannot be isolated or fragmented.
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4. View the mass spectrum of the High Mass Calibration Mix/matrix mixture:

a. Set the LTQ XL parameters (see “Setting the LTQ XL Parameters for Tuning” on 
page 63) with the following exceptions: select High in the Mass Range list and type 
4000 in the Last Mass (m/z) box.

b. Set the MALDI source parameters as described in “Setting the MALDI Source 
Parameters for Tuning” on page 66.

c. In the MALDI Source dialog box, select a spot on the target plate that has a 
homogeneous layer of the calibrant/matrix.

d. Click the On/Standby button to turn the laser on. 

The laser begins firing. 

e. On the File/Display toolbar in the Tune Plus window, click the Display Spectrum 
View. 

The spectrum view opens.

5. Monitor the spectrum for the masses of interest.

The High Mass Calibration Mix contains the five peptides listed in Table 10.

Figure 46 on page 84 shows the mass spectrum of the peptides in the High Mass 
Calibration Mix.

Table 10. Monoisotopic masses of the five peptides in the High Mass Range Calibration Mix

Peptide (M+H)+ Monoisotopic mass 

MRFA 524.27 

Bradykinin 1060.57 

ACTH 1-16 1936.99 

Melittin 2845.75 

ACTH 7-38 3657.93 

On

Standby
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Calibrating the Mass Spectrometer
Figure 46. Mass spectrum of the High Mass Calibration Mix

6. When you observe a stable mass spectrum, on the Control/Scan Mode toolbar, click the 
Calibrate button. 

The Calibrate dialog box opens with the Automatic page shown by default (Figure 47 on 
page 85).

MRFA

Bradykinin

ACTH 1-16

Melittin

ACTH 7-38
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Calibrating the Mass Spectrometer
Figure 47. Calibrate dialog box

7. For Mass Range, select the High option. 

8. Click the Semi-Automatic tab.

The Semi-Automatic page opens (Figure 48 on page 86).
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Calibrating the Mass Spectrometer
Figure 48. Semi-automatic page with the parameters for high mass range calibration

9. In the What to Calibrate column, select the Select All check box.

10. Click Start. 
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Checking the Sensitivity of the MALDI LTQ XL System
You can check the sensitivity of the MALDI LTQ XL system by evaluating the signal-to-noise 
ratio of the 1046 m/z peak for a 1 fmol angiotensin II target spot. 

To test the sensitivity of the MALDI LTQ XL system

1. Specify the acquisition parameters for the LTQ XL mass spectrometer:

a. Start Tune Plus.

b. On the Control/Scan Mode toolbar, click the On/Standby button to turn the mass 
spectrometer on. 

c. If you have not already done so, create a tune file for angiotensin II. For instructions 
on tuning the mass spectrometer for a specific analyte, see “Tuning on an Analyte” on 
page 62.

d. On the Control/Scan Mode toolbar, click the Centroid/Profile button to change the 
data type to profile. 

e. Click the Positive/Negative button to change the ion polarity mode to positive. 

f. On the Control/Scan Mode toolbar, click the Define Scan button. 

The Define Scan dialog box opens (Figure 49). 

Figure 49. Define Scan dialog box

On

Standby

Profile

Centroid

Positive
Polarity

Negative
Polarity
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g. Use the default settings in the Define Scan dialog box with the following exceptions 
(see Table 11). 

2. Specify the acquisition parameters for the MALDI source:

a. In the Tune Plus window, choose Setup > MALDI Source. 

The MALDI Source dialog box opens (Figure 35 on page 67).

b. Click the Setup tab. 

The Setup page opens (Figure 50 on page 89).

Table 11. Define Scan settings

Area Parameter Setting

Scan Description Mass Range Normal

Scan Rate Normal

Scan Type Full

Scan Range First Mass (m/z) 500.00

Last Mass (m/z) 2000.00
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Figure 50. Setup page

c. Use the default settings in the Setup page of the MALDI Source dialog box with the 
following exceptions (see Table 12 on page 90). 

Use the Semiautomatic page of the Tune dialog box to determine the optimal laser 
energy for the angiotensin II target spots. For information on optimizing the laser 
energy, see “Tuning the Laser Energy with the Semi-Automatic Function” on 
page 73.
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d. Click Apply. 

e. Click the Acquire tab.

The Acquire page opens (Figure 51).

Figure 51. Acquire page

f. Specify an appropriate file name and folder for the raw data file.

g. In the Acquisition mode area, type 10 in the Number Scan box.

h. Make sure that the Go to Standby when Finished check box is clear.

3. Insert the target plate with the sensitivity target spots into the MALDI sample module.

Table 12. Setup page settings 

Area Parameter Setting

Sampling pattern settings Plate Motion Manual

Option check box Cleared

Auto Spectrum Filter (ASF) Microscans per Step 5

Laser Settings AGC Off

Num Laser Shot Per 
Microscan

5

Laser Energy Varies (30 to 50)

Number Sweep Laser Shot 5
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For information on preparing the sensitivity targets, see “Preparing the Sensitivity Test 
Targets” on page 186. For information on loading a sample plate, see “Loading a Sample 
Plate into the MALDI Sample Module” on page 56.

4. Acquire data at several positions within the well spot.

For information about acquiring sample data in Tune Plus, see Chapter 6, “Acquiring 
Sample Data in Tune Plus.” 

5. Review the raw data file in Qual Browser (Figure 52).

The intensities of the noise peaks on either side of the 1046 m/z peak should be no greater 
than one-tenth the intensity of the 1046 m/z peak.

Figure 52. Qual Browser with a raw data file acquired from an Angiotensin II target spot
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Checking the Calibration
To verify the performance of the mass spectrometer, check the calibration periodically. 
Checking the calibration does not update the calibration settings in the master calibration file. 
The date stamp of the master calibration file changes when you perform a calibration check 
because the master calibration file stores a record of the calibration check.

Because the mass spectrometer performs an internal calibration check of the multipole RF 
frequency and the main RF frequency, these calibration checks do not require external 
calibration samples. The Normal Mass Calibration Mix/matrix mixture is used for the rest of 
the calibration checks.

To perform a calibration check

1. Prepare the Normal Mass Calibration Mix/matrix mixture and spot the target plate as 
described in “Preparing the Mass Calibration Targets” on page 183. 

2. Load the plate into the MALDI sample module as described in “Loading a Sample Plate 
into the MALDI Sample Module” on page 56.

3. View the mass spectrum of the Normal Mass Calibration Mix/matrix mixture:

a. Set the LTQ XL parameters as described in “Setting the LTQ XL Parameters for 
Tuning” on page 63.

b. Set the MALDI source parameters as described in “Setting the MALDI Source 
Parameters for Tuning” on page 66.

c. In the MALDI Source dialog box, select a spot on the target plate that has a 
homogeneous coating of the calibrant/matrix.

d. Click the On/Standby button to turn on the MALDI laser.

e. Observe the Spectrum view in Tune Plus. 

4. In the Tune Plus window, on the Control/Scan Mode toolbar, click the Calibrate button. 

The Calibrate dialog box opens (Figure 44 on page 80). 

5. Click the Check tab.

The Check page opens (Figure 53 on page 93).

On

Standby
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Figure 53. Check page

6. Select the check boxes for the calibration parameters of interest. 

7. Click Start.
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6

Acquiring Sample Data in Tune Plus

This chapter describes how to view and acquire mass spectral data in Tune Plus. When you 
acquire sample data using Tune Plus, you can set the data acquisition parameters in an 
interactive manner or use a stored instrument method. 

For information on creating instrument methods, see “Creating an Instrument Method” on 
page 113.

Acquiring Sample Data Interactively in Tune Plus 
This procedure shows typical settings for acquiring mass spectral data on a BSA digest/DHB 
matrix sample in the positive ion polarity mode and the high mass range with the MALDI 
LTQ XL system. 

To acquire data interactively in Tune Plus, follow these procedures:

• “Setting the LTQ XL Parameters for Sample Data,” next section

• “Setting the MALDI Source Parameters” on page 97 

• “Acquiring a Raw Data File in Tune Plus” on page 101

Setting the LTQ XL Parameters for Sample Data

To set the LTQ XL mass spectrometer parameters 

1. On the Windows taskbar, choose Start > All Programs > Thermo Instruments > LTQ > 
model Tune. 

The Tune Plus window opens (Figure 22 on page 36). 

Contents

• Acquiring Sample Data Interactively in Tune Plus

• Using an Instrument Method to Acquire Sample Data in Tune Plus

• Setting Up to Acquire MS/MS Data 

Note  For LTQ version 2.5.0 or earlier, the path is Start > All Programs > Xcalibur > 
model Tune. 
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Acquiring Sample Data Interactively in Tune Plus
2. On the Control/Scan Mode toolbar, click the On/Standby button to turn the LTQ XL 
mass spectrometer on.

3. On the File/Display toolbar, click the Open button.

4. Browse for and select the tune file you created in “Tuning the Laser Energy with the 
Semi-Automatic Function” on page 73. 

5. Click Open. 

6. On the Control/Scan Mode toolbar, click the Centroid/Profile button to switch the data 
type to profile. 

7. On the Control/Scan Mode toolbar, click the Positive/Negative button to switch the ion 
polarity mode to positive.

8. On the Control/Scan Mode toolbar, click the Define Scan button.

The Define Scan dialog box opens (Figure 54). 

Figure 54. Define Scan dialog box with settings for data acquisition in the full-scan mode

Use the default settings in the Define Scan dialog box with the exceptions listed in 
Table 13. 

Table 13. Scan settings  (Sheet 1 of 2)

Area Parameter Setting Comments

Scan Description Mass Range High

Scan Rate Normal

Scan Type Full

On

Standby

Profile

Centroid

Positive
Polarity

Negative
Polarity
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9. Click OK to save the settings and close the dialog box. 

You have now finished setting the LTQ XL mass spectrometer parameters. Continue to 
“Setting the MALDI Source Parameters,” next, to set the MALDI source parameters in the 
Tune Plus window. 

Setting the MALDI Source Parameters

The next step in the process of acquiring data with the MALDI LTQ XL system is to set the 
parameters for the MALDI source. 

To set the MALDI parameters in Tune Plus

1. In the Tune Plus window, choose Setup > MALDI Source. 

The MALDI Source dialog box opens with the Control page shown by default (Figure 55 
on page 98).

Scan Ranges First Mass (m/z) 700.00 Specifies that the first mass in the scan 
range is m/z 700.00. ‘First Mass’ 
values for protein digest samples of 
600 to 800 are common in a MALDI 
scan range, depending on the matrix 
used. For calibration mix use a value 
of 500. For small molecules adjust 
accordingly.

Last Mass (m/z) 3000.00

Microscans Varies Use 2 to 3 or more if needed.

Table 13. Scan settings  (Sheet 2 of 2)

Area Parameter Setting Comments
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Figure 55. Control page with settings for a BSA digest/DHB matrix sample
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2. Use the information in Table 14 to set the parameters for the MALDI source. 

For a BSA digest/DHB matrix mixture, Figure 55 on page 98 shows typical Control page 
settings and Figure 56 on page 100 shows typical Setup page settings. For information on 
determining the optimal laser energy for your samples, see “Adjusting the Laser Energy 
Manually” on page 76.

Table 14. Typical MALDI source settings based on the matrix compound 

Parameters DHB matrix CHCA matrix

Laser energy (μJ) 20 (approximately 15 to 
20 μJ higher than for 
CHCA)

5

Number Laser Shots 
(with AGC in the Off mode)

3 to 5 3 to 5

Number Sweep Laser Shots
(Setup page)

0 to 3 3 to 5

ASF On settings 

Microscans per Step for ASF Off
(This setting must be a multiple 
of the Microscans setting in the 
Define Scan dialog box)

3 3

Threshold type (Setup page) Peak height

MS threshold (Setup page) ≥5000 ≥5000

MS2 threshold (Setup page) 300 to 1000 300 to 1000
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Figure 56. Setup page with typical settings for a BSA digest/DHB matrix sample

3. Click Apply. 

You have now set the MALDI parameters for data acquisition. With the MALDI Source 
dialog box open, go to the next section, “Acquiring a Raw Data File in Tune Plus.” 
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Acquiring a Raw Data File in Tune Plus

To acquire data in Tune Plus

1. Ensure that the On/Standby button on the Tune Plus toolbar is set to On, and that the 
MALDI Source dialog box is open.

2. In the MALDI Source dialog box, click the Acquire tab.

The Acquire page opens (Figure 57).

Figure 57. Acquire page

3. Select a well plate spot by clicking a spot in the sample position map at the bottom of the 
MALDI Source dialog box.

The X-Y mechanism of the MALDI source moves the sample plate to position the laser 
over the requested sample position. After you select it, the position is highlighted in red 
until the plate moves to the specified position. Then the position is highlighted in green. 

4. In the Folder box, browse to the folder where you want the data file stored.

On

Well plate location
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5. In the File name box, type the file name.

A complete file name consists of three parts, separated by underscores: the base file name 
box, the sample position box, and the suffix box. The program automatically fills in the 
sample position box with the current well plate location and the suffix box with a date 
stamp.

6. (Optional) In the Sample Name box, type the sample name. 

7. (Optional) In the Comment box, type additional comments about the sample or 
experiment. 

8. In the Acquisition mode area, select the Number Scan option and type a value for the 
number of scans to be collected per data file in the adjacent box.

9. Click the On/Standby button to turn the laser on. 

The laser begins firing, and the mass spectrum appears in the Tune Plus window. 

10. Click the Acquire Data button at the bottom of the MALDI Source dialog box to turn 
on the MALDI source and begin saving data to the specified file. 

The instrument continues to acquire data and save it to the specified file until you click 
the Acquire Data button again or it acquires the specified number of scans per file. The 
data file is stored in the specified folder and has a .raw file extension.

Using an Instrument Method to Acquire Sample Data in Tune Plus
Before you use an instrument method to acquire a sequence of data files in Xcalibur Sequence 
Setup, you can test the method by acquiring a sample data file in Tune Plus.

Note  The LTQ XL mass spectrometer and the MALDI source have their own 
independent On/Standby or On/Off buttons. 

The LTQ On/Standby button( ) is located in the Tune Plus toolbar. Clicking this 
button places the LTQ XL mass spectrometer in the On mode, making it ready to 
acquire data. The MALDI source switches from the Off mode to the Standby mode. 

The MALDI source (Turn on/Turn off MALDI source) button ( ) is located at the 
lower-left corner of the MALDI Source dialog box. Clicking this button starts the 
laser firing. 

For more information on the operation modes for the MALDI source, see “Turning 
the MALDI Source On” on page 37.

On

Standby
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To use a stored instrument method to acquire sample data in Tune Plus

1. On the Windows taskbar, choose Start > All Programs > Thermo Instruments > LTQ > 
model Tune. 

The Tune Plus window opens (Figure 22 on page 36). 

2. On the Control/Scan Mode toolbar, click the On/Standby button turn the LTQ XL mass 
spectrometer on.

3. In the Tune Plus window, choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page shown by default (Figure 35 
on page 67). 

4. Click the Acquire tab.

The Acquire page opens (Figure 58).

Figure 58. Acquire page

5. Make the appropriate entries and selections for the data file location and name (see step 4 
and step 5 on page 101).

Note  For LTQ version 2.5.0 or earlier, the path is Start > All Programs > Xcalibur > 
model Tune. 

On

Standby
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6. Select the Use Instrument method check box, and then select an instrument method 
(Figure 59).

Figure 59. Acquire page

Note  You can select the Go to Standby when Finished check box to place the 
LTQ XL mass spectrometer in Standby mode at the end of data acquisition. 
When the LTQ XL mass spectrometer is in Standby mode, the high voltages and 
nitrogen gas flow are off.
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7. Click Apply.

8. Click the Acquire Data button.

The laser starts firing. The system starts scanning and acquiring data (based on the 
settings in the instrument method) to an Xcalibur raw data file. When the system 
completes the instrument method, the MALDI source returns to the Off mode.

Setting Up to Acquire MS/MS Data
Before you perform full-scan MS/MS experiments, for best results, optimize the isolation 
width and the relative collision energy parameters for your analytes. You visually determine an 
appropriate isolation width to ensure the effective isolation of the ion of interest, and then you 
optimize the relative collision energy to ensure efficient fragmentation of the parent ion 
(precursor ion). The relative collision energy for a particular analysis depends on the type of 
sample you are analyzing. You can optimize the collision energy manually or use the 
automated process provided by the program.

To determine an appropriate isolation width and optimal collision energy for the ions of 
interest, follow these procedures: 

• “Determining the Optimum Isolation Width,” next section

• “Manually Optimizing the Collision Energy” on page 107 

• “Automatically Optimizing the Collision Energy” on page 109 

Determining the Optimum Isolation Width 

For this experiment, and for most applications, use the default settings for the advanced scan 
features, Activation Q and Activation Time. For more information about these parameters, 
refer to the Help. The Activation Q and Activation Time parameters appear in the Define 
Scan dialog box.

To manually optimize the isolation width for an MS/MS experiment

1. On the Control/Scan Mode toolbar in Tune Plus, click the On/Standby button to turn 
the LTQ XL mass spectrometer on.

2. On the Control/Scan Mode toolbar, ensure that the Profile data type is selected. 

3. On the Control/Scan Mode toolbar, click the Define Scan button. 

The Define Scan dialog box opens. Figure 60 on page 106 shows the scan settings for the 
1881.7 m/z precursor ion in a BSA digest/DHB matrix sample.

On

Standby

Profile
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Figure 60. Define Scan dialog box with initial settings to optimize the isolation width for m/z 1881.7

4. Ensure that the Parent Mass box contains the correct m/z value and that the scan range is 
appropriate.

5. Ensure that the value in the Normalized Collision Energy column is set to 0.

6. In the MSn Settings area, type 3.0 to specify an isolation width of m/z 3.0 in the Isolation 
Width column. 

7. Click Apply. Do not close the Define Scan dialog box. 

8. In the Tune Plus window, observe the mass spectrum for the parent ion of your analyte. 
Ensure that the readback value for the normalized intensity (NL) is relatively stable.

Normalized Collision 
Energy 

Scan
Ranges

Parent Mass 
(precursor)

Note  The optimum value for the Isolation Width is the smallest m/z width that gives 
a mass spectrum of maximum intensity for only the ions of interest. When the 
optimum Isolation Width is obtained, the value for the normalized intensity (NL) in 
the mass spectrum display is stable, and the mass peak for the parent ion is at its 
maximum intensity and appears symmetrical. An Isolation Width value that is less 
than the optimum value causes a substantial drop in the NL reading. A significant 
drop in sensitivity indicates that the ions of interest are not effectively isolated.
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9. Repeat step 6 and step 8, entering successively smaller values for the isolation width. 
Continue to observe the intensity of the mass spectrum of the parent ion, and ensure that 
the value for the normalized intensity (NL) is stable with each change you make to the 
isolation width.

Figure 61 shows the MS/MS precursor isolation spectra isolation widths of 1 and 3.

Figure 61. MS/MS spectrum for m/z 1881.7 with an isolation width of 3 (collision energy = 0)
)

Manually Optimizing the Collision Energy

To manually optimize the collision energy

1. In the Tune Plus window, ensure that the MS detector is on.

2. On the Control/Scan Mode toolbar, ensure that the Profile data type is selected. 

3. On the Control/Scan Mode toolbar, click the Define Scan button. 

The Define Scan dialog box opens (Figure 62 on page 108).

Note  The optimal isolation width is typically between 1 to 3. After you optimize the 
isolation width, you can compensate for minor changes in tune stability by increasing 
the isolation width value a small amount. This adjustment should be no larger than 
m/z = 1. 

Isolation width = 3

Isolation width = 1

1880.73
1881.64

1882.55

Profile
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Figure 62. Define Scan dialog box with typical settings for acquiring full-scan MS/MS data

4. Set the scan parameters for your analyte of interest. You must type a value for the parent 
mass in the Parent Mass box in the MSn Settings area. 

5. In the Normalized Collision Energy box under MSn Settings, type or select 35. 

6. Click Apply.

7. In the Tune Plus window, observe the mass spectrum of the product ions of your analyte 
of interest. 

Figure 63 on page 109 shows the MS/MS spectrum for the m/z 1881.7 precursor ion.

Beginning Normalized Collision 
Energy setting
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Figure 63. MS/MS spectrum for the m/z 1881.7 precursor ion

8. If necessary, increase the value for the normalized collision energy in increments of 5% 
and click Apply, until the intensity of the precursor ion is less than 5% of the intensity of 
the product ions.

Automatically Optimizing the Collision Energy

The optimum relative collision energy maximizes the product ion intensity. 

To automatically optimize the relative collision energy for an analyte of interest 

1. When you have clearly identified a mass-to-charge ratio of a product ion for your analyte 
of interest, in the Control/Scan Mode toolbar, click the Tune button. 

The Tune dialog box opens with the Automatic page shown by default (Figure 64 on 
page 110).
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Figure 64. Tune dialog box

2. Click the Collision Energy tab. 

The Collision Energy page opens (Figure 65 on page 110).

Figure 65. Collision Energy page 

3. Select the Product Ion Mass option.

4. In the Product Ion Mass box, type a value for one of the product ions of your analyte. 
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5. Click Start. 

6. In the Spectrum view of Tune Plus, observe the full-scan MS/MS spectrum of your 
analyte of interest. 

When the collision energy is optimized, the Accept Optimized Value dialog box appears. 
(Figure 66).

Figure 66. Accept Optimized Value dialog box

7. Click Accept. 

The new value appears in the Define Scan dialog box.

8. Click Cancel. 

After you optimize the relative collision energy, the MALDI LTQ XL system is ready to 
acquire MS/MS data on your analyte of interest.
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Automatically Acquiring Sample Data with Xcalibur

This chapter describes how to automate data acquisition for a set of samples analyzed with the 
MALDI LTQ XL system.

When you automate data acquisition with the Xcalibur data system, you create an instrument 
method specifying how the instrument collects spectra, and an acquisition sequence 
specifying which sample positions are to be examined and where the data is to be stored. 

The procedures in this chapter describe how to set up a data-dependent MS/MS experiment 
that can be used to identify the components of an enzyme digest. Refer to Xcalibur Help for 
more information on how to customize the Instrument Setup and Sequence Setup parameters 
for your experiment. 

Creating an Instrument Method
The instrument method defines the experimental parameters for data acquisition. When you 
use Xcalibur to acquire data, you select an instrument method for each sample that you run in 
the Sequence Setup view. You can also use instrument methods in Tune Plus.

This procedure describes how to create an instrument method with the Nth Order Double 
Play template. This template is useful for setting up an experiment where you acquire MS/MS 
data for the most intense precursor peaks in the MS spectrum. 

When you create an instrument method, you import a tune file for your analytes of interest. 
The tune file becomes part of the method and contains parameters that optimize the ion 
transmission for your analytes. For information on creating a tune file for your analytes, see 
“Tuning on an Analyte” on page 62.

Contents

• Creating an Instrument Method

• Creating an Acquisition Sequence 

• Acquiring Raw Data Files in Sequence Setup 
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To set up an instrument method based on the Nth Order Double Play template

1. From the Windows taskbar, chose Start > All Programs > Xcalibur > Xcalibur.

The Xcalibur Home Page opens (Figure 67). 

Figure 67. Xcalibur Home Page

2. Click the Instrument Setup button.

The Instrument Setup window opens with the New Method page displayed (Figure 68 on 
page 115). 
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Figure 68. Instrument Setup window with the New Method page

The remaining steps in this procedure describe how to set up an Nth Order Double-Play 
experiment suitable for an enzyme digest. 

3. Click the Nth order double play button

The Nth Order Double Play dialog box opens (Figure 69).

Figure 69. Nth Order Double Play dialog box

4. In the Analyze top N peaks box, type or select 50. 

When you run this experiment, the MALDI LTQ XL acquires data on the 50 most 
intense peaks in the mass spectrum.
Thermo Scientific MALDI Source Getting Started Guide 115



7 Automatically Acquiring Sample Data with Xcalibur
Creating an Instrument Method
5. Click OK. 

The template for an Nth Order Double Play experiment opens (Figure 70). 

Figure 70. Nth Order Double Play page with the Scan Event 1 settings

For the purpose of this tutorial, use the default settings in the Nth Order Double Play 
template (Figure 70) with the exception of the parameters listed in Table 15 on page 117 
and Table 16 on page 117. 

Tune file

Settings for
Scan Event 1
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The settings for the Scan event 1 area of the template are listed in Figure 16.

6. In the Tune method box, browse to the directory where you stored the tune file, and 
double-click the appropriate *.LTQtune file.

7. Set up the data dependent scan parameters for Scan Event 2:

a. To display the Scan Event 2 Settings area in the bottom portion of the window, click 
Scan Event 2 (Figure 71 on page 118).

Table 15. Basic settings for an Nth Order Double-Play experiment 

Area Parameter Setting

Acquisition mode Number of experiments to 
acquire

1

Experiment settings Tune method The tune file for the 
analyte of interest

Table 16. Scan event 1 settings for an Nth Order Double-Play experiment 

Area Parameter Setting

Scan Description Mass Range High

Data type Profile

Scan Ranges First Mass (m/z) 800.00

Last Mass (m/z) 4000.00
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Figure 71. Nth Order Double Play page with the Scan Event 2 settings

b. Select the Wideband Activation check box. 

Selecting the wideband activation check box increases the amount of fragmentation 
during mass analyzer collision-induced dissociation (CID).

c. Click Settings. 

The Data Dependent Settings dialog box opens (Figure 72 on page 119).

Settings for
Scan Event 2

Wideband Activation
check box
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Figure 72. Data Dependent Settings dialog box

d. In the Global list in the left pane, select Dynamic Exclusion.

The Dynamic Exclusion parameters are displayed but are greyed out (Figure 73). 

Figure 73. Dynamic Exclusion parameters

e. Click Enabled.

The Dynamic Exclusion parameters are activated (Figure 74 on page 120).
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Figure 74. Dynamic Exclusion parameters activated

f. With the exception of the High value for the Exclusion mass width (Table 17), use 
the default parameter settings. 

The exclusion mass width of 1.50 to 4.00 ensures that the mass spectrometer does 
not perform an MSn experiment on both the monoisotopic and most intense isotope 
peaks in the MS spectrum.

 

g. In the Experiment list in the left pane, select Charge State.

The Charge State settings are displayed (Figure 75 on page 121). 

Table 17. Exclusion mass width settings

Area Parameter Setting Result

Exclusion 
mass width

Low 1.50 An ion does not trigger a dependent scan if 
its mass falls within a range of 1.50 m/z 
units less than a mass on the exclusion list. 

High 4.00 An ion does not trigger a dependent scan if 
its mass falls within a range of 4.00 m/z 
units greater than a mass on the exclusion 
list. 
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Figure 75. Charge State parameters

h. Ensure that the Enable charge state screening check box is selected. 

i. In the Scan Event list in the left pane, select Current Scan Event.

The Current Scan Event parameters are displayed (Figure 76).

Figure 76. Current Scan Event parameters

j. Use the default parameter settings on the Current Scan Events page (Figure 76) with 
the exception of the Minimum signal threshold setting listed in Table 18 page 122.
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k. In the Scan Event list in the left pane, select Activation. 

The Activation parameters are displayed. Figure 77 shows typical settings for the 
Activation parameters.

Figure 77. Activation parameter settings

l. Use the default parameter settings with the exception of the settings listed Table 19. 

Table 18. Minimum signal threshold setting

Parameter Setting Result

Minimum signal 
threshold (counts)

300 Signals above 300 counts trigger MS/MS. Values 
from 100 to 500 are common. If an experiment 
quits before collecting all the MS/MS you expect, 
the threshold might be set too high.

Table 19. Activation parameter settings

Parameter Setting Comments

Default charge state 1

Isolation width (m/z) 3.0

Normalized collision energy The default setting is 35. Use the normalized 
collision energy value 
determined by following 
the procedure in “Setting 
Up to Acquire MS/MS 
Data” on page 105.
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8. Click OK.

9. Choose File > Save As. 

The Save As dialog box opens.

10. In the File name box, type a descriptive file name for your instrument method.

11. Click Save.

The File Summary Information dialog box appears.

12. Type a comment in the Comment box, and then click OK to save the instrument method 
and close the dialog box.

Instrument method files have the file extension .meth.

Creating an Acquisition Sequence
Creating an acquisition sequence allows you to keep all the data you collect from a single 
sample plate together and organized. The sequence file (*.sld) you create stores the data file 
path and the location on the plate for each sample, plus the sample name and any comments 
you add. 

To create an acquisition sequence 

1. On the Windows taskbar, choose Start > All Programs > Xcalibur > Xcalibur.

The Xcalibur Home Page opens (Figure 67 on page 114). 

2. Click the Sequence Setup button.

The Sequence Setup window opens (Figure 78 on page 124). 
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Figure 78. Sequence Setup window

3. Choose File > New. 

The New Sequence Template dialog box opens (Figure 79 on page 125).
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Figure 79. New Sequence Template dialog box

4. Fill in the parameters in the General area:

a. In the Base File Name box, type a base file name. 

Xcalibur appends a suffix to this base file name to create a data file name for each 
sample in the sequence. 

b. In the Path box, select a directory path for storing your data files.

c. To find and open the instrument method that you created in the previous procedure, 
“Creating an Instrument Method” on page 113, click Browse next to the Instrument 
Method box. 

d. Do not specify a processing method or a calibration file (leave these selections blank), 
unless you want Xcalibur to process the raw data files as it acquires them. You do not 
need a processing method or a calibration file to acquire raw data files. 

For information on creating processing methods and calibration files, refer to the 
Xcalibur data system Help.
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5. Select the sample positions:

a. In the Samples area, click Select Vials. 

The MALDI - Select Sample Spots dialog box opens (Figure 80).

Figure 80. MALDI – Select Sample Spots dialog box

b. Select the positions where you have placed samples on the plate. Click individual 
positions to select them, or drag your cursor over a range to select a range of 
positions. 

c. Click OK.

6. If you are using this sequence to acquire data files (rather than acquire and process, or 
process only), use the default settings for the rest of the parameters in the New Sequence 
Template dialog box.

7. Click OK. 

A sample list appears in the Sequence Setup window (Figure 81 on page 127).

Note  Data acquisition proceeds by rows rather than by columns.
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Figure 81. Xcalibur Sequence Setup window with a typical MALDI acquisition sequence 

8. To display more columns, change the column arrangement:

a. On the toolbar, click the Column Arrangement button. 

The Column Arrangement dialog box opens (Figure 82).

Figure 82. Column Arrangement dialog box with the columns used for a MALDI sequence

b. In the Available Columns list, select the columns of interest and click Add to add 
them to the Displayed Columns list. 

c. When you are done, click OK. 
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9. Save the sequence:

a. On the File/Display toolbar, click the Save button.

The File Summary Information dialog box opens. 

b. Type a description or summary of the sequence in the Description box. 

c. Click OK.

The Save As dialog box opens. 

d. Specify the path and file name for the acquisition sequence and click Save. 

The file extension for sequence files is .sld.

The Acquisition Sequence is now saved. You are ready to run the sequence and acquire data. 
With the Acquisition Sequence open in the Sequence Setup view, go to the next topic, 
“Acquiring Raw Data Files in Sequence Setup.” 

Acquiring Raw Data Files in Sequence Setup
To run your sequence and acquire data

1. Prepare your samples as described in Appendix B, “Sample Preparation.” 

2. Ensure that the sample plate is loaded and the MALDI source has pumped down to the 
operating vacuum level. 

For information on loading a sample plate into the MALDI sample module, see “Loading 
a Sample Plate into the MALDI Sample Module” on page 56.

3. On the Sequence Setup toolbar, click the Run Sequence button. 

The Run Sequence dialog box opens (Figure 84 on page 130).

4. If the instruments in use has changed, the Change Instruments In Use dialog box opens 
on top of the Run Sequence dialog box (Figure 83 on page 129). 
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Figure 83. Change Instruments In Use dialog box 

By default the MALDI Source is listed as the start instrument.

5. Click OK.

The settings are saved and the Change Instruments In Use dialog box closes. 

6. Use the default settings in the Run Sequence dialog box (Figure 84 on page 130), with 
the exception of the settings listed Table 20. 

Table 20. Run Sequence dialog box settings 

Area Parameter Setting Result

Acquisition Options Start When Ready Xcalibur adds the 
sequence to the end of 
the acquisition queue 
when you click OK. 

After Sequence Set 
Systems

Set System Standby The mass 
spectrometer returns 
to Standby mode 
when the sequence 
finishes. 

User user name Specifies the name of 
the operator.

Run Rows range of rows to run Specifies the sequence 
rows to run.

Priority Sequence Xcalibur places the 
sequence at the end of 
the acquisition queue. 

MALDI Source 
selected as the 
start instrument
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Figure 84. Run Sequence dialog box with settings for acquiring MALDI data

7. Click OK.

If there are no other runs in the acquisition queue, data acquisition for this sequence 
begins. For tips about running acquisition sequences to collect tissue imaging sequences, 
see Chapter 8, “Tissue Imaging.” 

8. Check the acquisition queue. If the Information view is not visible, click the Info View 
button and then click the Acquisition Queue tab.

You can analyze the MS/MS data you acquire using the procedures in this chapter using 
BioWorks. See Chapter 9, “Identifying Proteins Using BioWorks.” 

Start Instrument Number of rows submitted 
to the acquisition queue
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Tissue Imaging

This chapter describes how to prepare tissue samples for imaging with the MALDI LTQ XL 
system and how to take optical and mass spectral scans of the tissue samples.

Using MALDI mass spectrometry, you can use the tissue imaging feature to acquire mass 
spectral data on the spatial distribution of small molecules or peptides in a tissue sample. Use 
ImageQuest™ after data acquisition when you want to visualize and process the data. You 
must get a license to enable the tissue imaging feature of MALDI.

Contents

• Getting a License for the Tissue Imaging Feature

• Preparing Tissue Slides 

• Loading the Tissue Slides onto the Adapter Plate 

• Acquiring a Bitmap Image with an External Scanner 

• Testing the MALDI Matrix 

• Applying the MALDI Matrix to the Tissue Samples 

• Importing a Bitmap Image into the Tissue Imaging Page 

• Creating a MALDI Position File Using an Imported Bitmap Image 

• Creating a MALDI Position File Using the MALDI Camera 

• Acquiring Mass Spectral Data from Tissue Samples Using Tune Plus 

• Acquiring Mass Spectral Data from Tissue Slides Using Xcalibur 
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Getting a License for the Tissue Imaging Feature
To get a license for the MALDI tissue imaging feature

1. Install the LTQ XL instrument control program according to the instructions on the CD 
cover.

2. Get a new license code from Thermo Fisher Scientific. See the next topic, “Getting a New 
License Code.” 

3. Install the new license code as described in “Installing a New License Code” on page 134.

Getting a New License Code

To get a license code, use e-mail. 

To get a license code

1. Choose Start > All Programs > Thermo Foundation 1.0 > Instrument Configuration. 

The Xcalibur Instrument Configuration dialog box opens (Figure 17 on page 28).

2. In the Configured Devices list, double-click the LTQ XL MS button.

The LTQ XL Configuration dialog box opens (Figure 19 on page 30).

3. In the list on the left side of the dialog box, select License.

If you do not have a license for the tissue imaging feature, the message in Figure 85 
appears.

Note  For Xcalibur version 2.0.7 or earlier, the path is Start > All Programs > 
Xcalibur > Instrument Configuration. 
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Figure 85. LTQ XL Configuration dialog box with License selected

4. Click Change license. 

The LTQ License dialog box opens (Figure 86).

Figure 86. LTQ License dialog box

5. Click Reset.

A message box opens:

If you reset the license, your existing license information will be invalidated and you 
will need to obtain a new license for this product. Do you wish to continue?

6. Click Yes to reset the license key.

A new license key appears in the License box (Figure 87).
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Figure 87. LTQ License dialog box with reset license key

7. Highlight the license key in the License box.

8. Copy (CTRL+C) the license key to the Windows Clipboard. 

9. Send an e-mail message to licenses.ms@thermo.com: 

a. In the subject line, type License Request. 

b. In the body of the e-mail message, paste (CTRL+V) the license key, and then type the 
following:

• Your name

• Your company name

• Your company address 

• Your company phone number with your extension 

• The serial number that appears below the bar code on the back of the LTQ 2.5 
software CD case 

When Thermo Fisher Scientific Customer Support sends you a new license code, install it as 
described in the next topic.

Installing a New License Code

After you receive your new license code from Thermo Fisher Scientific Customer Support, 
install it as follows: 
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To install the license code

1. Choose Start > All Programs > Thermo Foundation 1.0 > Instrument Configuration. 

The Xcalibur Instrument Configuration dialog box opens (Figure 17 on page 28).

2. In the Configured Devices list, double-click the LTQ XL button.

The LTQ XL Configuration dialog box opens (Figure 19 on page 30).

3. In the list on the left side of the dialog box, select License.

4. Click Change license. 

The LTQ License dialog box opens (Figure 87 on page 134).

5. In the License box, type the new license number, or copy the license number from the 
e-mail sent from Thermo Fisher Scientific and paste it into the box. 

To avoid copying extra spaces, you can copy the license number from the e-mail and paste 
it into Notepad™ or Wordpad™. Then carefully select the number, and copy it from 
Notepad or Wordpad and paste it in the License box.

6. After you have pasted the correct number in the License box (without any extra spaces), 
click Set. 

A message box appears:

The new license number has been set.

7. Click OK. 

A message appears in the LTQ XL Configuration dialog box:

You are licensed for all standard LTQ features and the following additional LTQ 
features: Tissue Imaging.

8. Click OK. 

9. Click OK again to close the LTQ License MALDI dialog box. 

10. Click Done.

A message box appears:

Note  For Xcalibur version 2.0.7 or earlier, the path is Start > All Programs > 
Xcalibur > Instrument Configuration. 

Tip  Take care not to copy and paste any extra spaces. Pasting a space in the License 
box causes the license number to be declined.

IMPORTANT  Do not click Reset after you install the new license code. Reset 
invalidates your license.
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In order for the configuration change to take effect, you will need to reboot the data 
system and then the LTQ.

11. Click OK.

12. Reboot the data system computer.

13. Reboot the MALDI LTQ XL system:

a. Press the Reset button on the power entry panel.

b. Take the LTQ XL mass spectrometer out of Standby mode.

c. Take the MALDI source out of Standby mode.

d. Place the MALDI source back into Standby mode.

For more information on rebooting the MALDI LTQ XL system, see “Rebooting the 
MALDI LTQ XL System” on page 40.

Preparing Tissue Slides
For best results, section and prepare the sample just prior to MS analysis.

To prepare the tissue sample and apply it to a slide

1. Flash freeze the sample in liquid nitrogen or isopentane, and then store the sample 
at -80 °C until you are ready to section the tissue.

2. Slice the sample and place it on a slide.

The most commonly used thickness for a tissue sample is 10 to 12 μm. Sections thinner 
than 10 μm are too close to cell size and might not provide optimal results.

You can use either conductive or non-conductive slides with the MALDI LTQ XL 
system. Because linear ion traps do not use high ion extraction potentials, they are not as 
susceptible to inhomogeneities in the field that would affect the ion packet, as opposed to 
axial MALDI time-of-flight instruments.

3. Prior to applying the MALDI matrix, place the slide with the sample in a desiccator for 
about 30 minutes.

4. \As necessary, fix or wash the sample to remove compounds such as salts and lipids that 
can interfere with the results. 

IMPORTANT  Before you spray the matrix on the tissue sections (“Acquiring a Bitmap 
Image with an External Scanner” on page 139), acquire an optical image of the tissue 
slides. The matrix spray coats the tissue with a layer of white crystals. These crystals 
looks like a white cloud on top of the tissue and make it very difficult to see the tissue 
below, especially when the sample plate is inside the MALDI sample module. 
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5. (Optional) Outline the sample areas on the back of the slide with a marker. After you coat 
the tissue with the matrix, distinguishing the tissue and the matrix becomes difficult.

Loading the Tissue Slides onto the Adapter Plate
Two adapter plates are provided with the MALDI tissue imaging kit: one for holding glass 
slides and one for holding stainless steel slides. The adapter plate for stainless steel slides 
incorporates magnets to secure the slides. The adapter plate for glass slides holds two slides 
secured with two retaining clips each. 

The adapter plates for tissue imaging use the same base plate as the 96- and 384-well plates. 
You must connect the plate to the base plate before loading it into the MALDI sample 
module. For instruction on connecting the top plate (adapter or well plate) to the base plate, 
see “Assembling the Sample Plate” on page 55. 

When you load the plate assembly into the MALDI sample compartment (see “Loading a 
Sample Plate into the MALDI Sample Module” on page 56), the MALDI imaging system 
recognizes the plate you have inserted as a tissue plate by the marks on the adapter plate.

Figure 88 shows the two adapter plates for slides and the base plate.

Note  Take care not to remove the analyte of interest when rinsing tissue sections with 
solvents. When possible, select an appropriate wash solvent based on the relative 
solubilities of the analyte and contaminant. 

CAUTION  Only use a marker pen to place an identifying label on your plates. Do not 
tape anything to the sample plates, as doing so can cause the sample plate to jam 
inside the MALDI sample module.
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Figure 88. Adapter plates for glass slides and stainless steel slides

Adapter plate 
for stainless steel slides

Adapter plate
for glass slides

Base plate

CAUTION  Fit the top plate snugly to the base plate. Loading a misaligned plate assembly 
into the MALDI sample module can damage the MALDI source.

CAUTION  Do not tape anything to the sample plate. After the plate is loaded into the 
upper chamber of the XYZ mechanism, there is very little space between the plate and the 
ion transfer optics. Loading sample plates with taped objects into the MALDI sample 
module can damage the MALDI source.
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To secure the glass slides to the adapter plate

1. Turn the adapter plate over so that the retaining clips are visible. See Figure 89.

Figure 89. Back side of the adapter plate for glass slides

2. Pull the retaining clips away from the slide slots.

3. With the tissue samples facing the front of the adapter plate, place the glass slides in the 
slide slots.

4. Push the retaining clips toward the slide slots to retain the slides.

Acquiring a Bitmap Image with an External Scanner
The MALDI tissue imaging kit includes an HP optical scanner. After you create a bitmap 
image of your tissue slides with the scanner, you can import the images onto the Tissue 
Imaging page of the MALDI Source dialog box in Tune Plus.

To create a bitmap image of your tissue slides with the optical scanner

1. Load your slides onto the adapter plate.

2. Place the scanner frame on top of the scanner glass. See Figure 90 on page 140.

Retaining clips

Retaining clips

Tip  Before applying the matrix, use a marker on the back side of the glass microscope slide 
to outline the tissue. The marker always shows through (whether you scan the image with 
the HP scanner or the MALDI camera), even after coating the tissue with matrix. 
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Figure 90. HP scanner with scanner frame on top of the scanner glass

3. Place the adapter plate into the scanner frame. The tissue slides must be facing the 
scanner glass.

4. From the computer desktop, click the HP Solution Center icon.

The Solution Center window opens (Figure 91).

Figure 91. HP Solution Center window

Scanner frame
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5. Click Scan Picture.

The Scanning from the Scan Picture button dialog box opens (Figure 92).

Figure 92. Scanning from the Scan Picture button dialog box

6. Make the following selections:

• Under What are you scanning?, select the Picture option and the Scan originals 
from glass option.

• Under Where do you want to send the scanned images?, in the File Type list, select 
Bitmap Image (*.bmp).

On the Tissue Imaging page of the MALDI Source dialog box in Tune Plus, you can 
only open image files saved as bitmap images.

• Select the Show Preview check box.

7. Click HP Photosmart Premier Save Options.

The HP Photosmart Premier Save Options for the Scan Picture button dialog box opens 
(Figure 93 on page 142).
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Figure 93. HP Photosmart Premier Save Options for the Scan Picture button dialog box

8. Make the following selections and entries:

• In the File Type area, select Bitmap Image (*.bmp).

• In the Base File Name area, type an appropriate name to identify the file.

• In the Save Location area, browse to or type the location where you want to store the 
bitmap image files. 

9. Click OK to accept the settings and return to the Scanning from the Scan Picture button 
dialog box (Figure 92 on page 141).

10. Click Scan Picture Settings.

The Scan Picture Settings for the Scan picture button dialog box opens (Figure 94 on 
page 143).
142 MALDI Source Getting Started Guide Thermo Scientific



 8 Tissue Imaging
Testing the MALDI Matrix
Figure 94. Scan Picture Settings for the Scan Picture button dialog box

11. Make the following selections:

• In the Resolution (ppi) list, select 600.

• In the Output Type list, select Millions of Colors.

• Under When scanning pictures from the glass, select the scan single picture to file 
option.

12. To accept the settings and return to the Scanning from the Scan Picture button dialog 
box, Click OK.

13. Click Scan.

The scanning process begins. The image is stored to the specified file location as a bitmap 
image (*.bmp).

Testing the MALDI Matrix
For best results, before coating the entire tissue, test the MALDI matrix you plan to use by 
analyzing a test spot on a tissue sample. For information on selecting an appropriate MALDI 
matrix, see Appendix B, “Sample Preparation.” 
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To test the MALDI matrix

1. Prepare the tissue slide (see “Preparing Tissue Slides” on page 136).

2. Use a spotter to spot the tissue with one or more MALDI matrix compounds. Mark the 
spotted areas and label the spots if you are testing more than one type of MALDI matrix.

3. Load the tissue slide onto the adapter plate (see “Loading the Tissue Slides onto the 
Adapter Plate” on page 137).

4. Connect the adapter plate to the base plate (see“Assembling the Sample Plate” on 
page 55).

5. Load the sample plate into the MALDI sample module (see “Loading a Sample Plate into 
the MALDI Sample Module” on page 56).

6. As you view the mass spectrum produced by the test spot (see “Interactively Acquiring 
Data from Tissue Samples” on page 157), manually optimize the tune parameters. After 
you determine the optimum tune parameters for your sample (see Table 5 on page 62), 
save the tune parameters in a tune file. 

7. Eject the sample plate from the MALDI sample module and prepare the tissue sample for 
analysis.

Applying the MALDI Matrix to the Tissue Samples
The key to matrix application for determining compound distribution in a tissue is to apply 
the matrix as uniformly as possible, forming the smallest crystals possible when the matrix 
co-crystallizes with the analyte. You can apply the MALDI matrix with one of the following 
tools:

• Airbrush

• Commercial nebulizer

• Spotters

Several commercial airbrushes suitable for applying the matrix are available from 
manufacturers such as Aldrich (thin-layer chromatography), Testors (Aztek airbrush), and 
Meinhard (nebulizers).

IMPORTANT  Before applying the matrix, use the HP scanner to scan a bitmap image of 
your tissue 

Tip  Before applying the matrix, use a marker to outline the tissue on the back side of the 
glass microscope slide. The marker always shows through (whether you scan the image 
with the HP scanner or the MALDI camera), even after coating the tissue with matrix. 
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To apply the matrix with an airbrush

1. Connect the airbrush to a high-purity, compressed nitrogen tank with a regulator for 
controlled air flow.

2. Set the airbrush on a stand.

3. Clamp on the air flow regulation lever.

4. Select the drop size.

5. Fill the liquid reservoir with the solvent used as a diluent for the matrix and test the 
drop size. 

6. Adjust the drop size if necessary to obtain the correct uniformity.

7. Fill the liquid reservoir with the matrix solution and test the drop size again.

8. Apply the matrix. 

The matrix should be a fine mist that covers the tissue and is not too dry or too wet.

Importing a Bitmap Image into the Tissue Imaging Page
You can import the bitmap image acquired by scanning the tissues slides with the HP scanner 
onto the Tissue Imaging page.

To import a bitmap image (600 ppi) created with the external scanner

1. On the Windows taskbar, choose Start > All Programs > Thermo Instruments > LTQ > 
model Tune. 

The Tune Plus window opens (Figure 22 on page 36).

2. Choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page displayed by default 
(Figure 95 on page 146).

Note  For LTQ version 2.5.0 or earlier, the path is Start > All Programs > Xcalibur > 
model Tune. 
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Figure 95. MALDI Source dialog box

3. Click the Tissue Imaging tab. 

The Tissue Imaging page opens (Figure 96 on page 147).
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Figure 96. Tissue Imaging page

4. Select the Use Tissue Imaging Feature check box.

5. In the Optical Image Scan area, select the Importing option (Figure 97 on page 148).
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Figure 97. Importing option in the Tissue Imaging page

6. Click Import Image.

The Open dialog box opens. 

7. Browse to the folder where you saved the scanned bitmap image, select the bitmap image 
of interest, and click Open.

The image created with the HP scanner appears in the Image Position box at the bottom 
of the Tissue Imaging page (Figure 98 on page 149).
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Figure 98. Imported bitmap image in the Image Position box
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Creating a MALDI Position File Using an Imported Bitmap Image
MALDI position files (*.MALDIpos) contain the bitmap image of the tissue and the MS 
scanning selections. If you do not make any MS scanning selections, the MALDI tissue 
imaging program uses the settings listed in Table 21.

With the above settings (assuming a rectangular tissue shape), the MALDI X-Y stage moves 
the sample plate in the pattern shown below. The circles represent the areas where the laser 
fires. The distance between each circle is the step size.

MALDI position files for tissue imaging plates are analogous to well plate locations of well 
plates. To acquire data with a sequence file, create MALDI position files of the areas of 
interest. 

To create a MALDI position file of a selected tissue area from an imported image

1. Import the bitmap image as described in “Importing a Bitmap Image into the Tissue 
Imaging Page” on page 145.

2. Select the tissue area where you want to acquire MS scan data, by doing one of the 
following:

• Crop and select the tissue area from a magnified view of the plate as described in 
step 3 and step 4.

• (Optional for large tissues) In the Image position box at the bottom of the MALDI 
Source dialog box, hold down the SHIFT key and drag the cursor to select the tissue 
area of interest. The selected rectangular area replaces the tissue image in the Image 
Position box at the bottom of the MALDI Source dialog box. 

Table 21. Default MALDI position file settings

Parameter Default setting

Tissue Shape Shape of the selected tissue area

Plate Motion Raster

Raster Step Size (μm) 100 

100 μm
raster step size
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3. Crop the tissue area from a magnified view of the plate:

a. Click the View Plate button. 

The Tissue Image window opens.

b. Ensure that the Fixed raster step size button is checked (Figure 99).

Figure 99. Tissue Image window

c. Click the Crop current image to a selected rectangle button.

d. Drag the cursor to crop the tissue area of interest. 

The cropped area appears in the Tissue Image window and all the toolbar buttons 
become available (see Figure 100 on page 152).

Fixed raster step size 
button
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Figure 100. Tissue Image window with cropped tissue area

4. In the cropped tissue image, refine the tissue area to be scanned:

a. Click the appropriate toolbar button (Table 22).

Table 22. Tissue Image dialog box toolbar image selection buttons

Button Selection

Rectangle

Ellipse

Free form area

Individual points
152 MALDI Source Getting Started Guide Thermo Scientific



 8 Tissue Imaging
Creating a MALDI Position File Using an Imported Bitmap Image
b. To select a rectangular, elliptical, or free form area, click the appropriate button on 
the toolbar, drag the cursor. To select individual points, click the Individual points 
button and click the points of interest in the image.

5. Click the Save button.

The Save As dialog box opens. 

6. Type a file name in the File name box and click Save. 

The MALDI program automatically saves the file as a bitmap image (*.bmp).

7. Click the Close button.

The cropped area is outlined in the Image Position box at the bottom of the MALDI 
Source dialog box. An outline of the selected tissue area appears to the right of the Image 
Position box. Figure 101 on page 154 shows a tissue area selected with the Free form area 
tool.

In the MS Image Scan area, the Tissue Shape list displays the shape of the selected tissue. 
The Plate Motion list displays the Raster selection, and the Raster Step Size box displays a 
value of 100 μm. 

Note  Clicking  in the Tissue Image window saves the image as a bitmap file, not 
as a MALDI position file.
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Figure 101. Tissue Imaging page with a view of the cropped tissue area

Cropped area on 
slide image

Free form tissue area
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8. In the MS Image Scan area of the Tissue Imaging page, for most applications, use the 
default Plate Motion and Raster Step Size that MALDI automatically selects (see Table 21 
on page 150). 

An estimate appears of the time required to complete the scan, assuming a scan rate of 
1 scan/second.

9. Click the Save button in the Tissue Imaging dialog box.

The Save Tissue Position File As dialog box opens.

10. Type a name in the File name box.

11. Click Save to save the file and close the dialog box.

By default, the program stores MALDI position files (*.MALDIpos) in the following 
folder:

C:\Xcalibur\methods

Creating a MALDI Position File Using the MALDI Camera
You can create a MALDI position file by scanning the sample plates with the MALDI camera. 

To create a MALDI position file by scanning the image with the MALDI camera

1. On the Windows taskbar, choose Start > All Programs > Thermo Instruments > LTQ > 
model Tune. 

The Tune Plus window opens (Figure 22 on page 36).

2. Choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page shown by default (Figure 95 
on page 146).

3. Load the sample plate with the tissue slides into the MALDI sample module as described 
in “Loading a Sample Plate into the MALDI Sample Module” on page 56.

4. Click the Tissue Imaging tab.

The Tissue Imaging page opens (Figure 96 on page 147).

5. Select the Use Tissue Imaging Feature check box.

6. In the Optical Image Scan area, select the Scanning option.

The image scanning features become available.

Note  For LTQ version 2.5.0 or earlier, the path is Start > All Programs > Xcalibur > 
model Tune. 
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7. In the Image Quality list, select an appropriate resolution value (see Table 23). Increasing 
the image quality increases both the file size of the image and the time required to scan it.

8. In the Image Area list, select the area of the plate to be scanned.

The available selections (Table 24) depend on the plate type in the MALDI sample 
module.

9. If you selected Selected Area for the image area, to select the tissue area of interest, hold 
down the SHIFT key and drag the cursor in the Plate Image portion of the MALDI 
Source dialog box.

The selected area is outlined in the Plate Image portion of the dialog box. An estimate 
appears of the time required to complete the optical scan.

10. Click the Scan Image button. 

The program scans the image. When the scan ends, the Tissue Image window appears. 

11. Select the tissue area of interest whose MS scan data you want to collect.

12. Click the Close button to close the Tissue Image window.

13. Choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page shown by default (Figure 95 
on page 146).

14. Click the Tissue Imaging tab.

The Tissue Imaging page opens (Figure 96 on page 147).

Table 23. Image Quality selections

Image Quality Description

Survey A very fast, low-resolution scan that reveals the position of the tissue 
sample on the plate

Coarse A fast scan that is appropriate if the image quality is not important

Normal A typical scan that is good for most applications

Fine A high-resolution scan that yields the best possible image

Table 24. Image Area selections

Plate type Selections

Stainless steel slides selected area, slide 1, slide 2, slide 3, and slide 4

Glass slides selected area, slide 1, and slide 2

Well plate selected area and whole plate
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15. In the MS Image Scan area, select the scanning options. 

An estimate appears of the time required to complete the scan assuming a scan rate of 
1 scan/second.

16. Save the image as a MALDI position file (*MALDIpos):

a. Click the Save button.

The Save Tissue Position File As dialog box opens.

b. Type a name in the File name box and click Save.

The program automatically saves the file as a MALDI position file. By default, the 
program stores MALDI position files (*.MALDIpos) in the following folder:

C:\Xcalibur\methods

Acquiring Mass Spectral Data from Tissue Samples Using Tune Plus
You can acquire a data file in Tune Plus using either of these procedures:

• “Interactively Acquiring Data from Tissue Samples,” next section

• “Using an Instrument Method to Acquire Data” on page 159 

Interactively Acquiring Data from Tissue Samples 

To interactively acquire mass spectral data from tissue samples in Tune Plus

1. Prepare the tissue slides (see “Preparing Tissue Slides” on page 136) and load them onto 
the adapter plate (see “Loading the Tissue Slides onto the Adapter Plate” on page 137). 

2. Use the HP scanner to scan the sample plate and acquire a bitmap image.

See “Acquiring a Bitmap Image with an External Scanner” on page 139.

3. Apply the MALDI matrix to the tissue slides.

See “Applying the MALDI Matrix to the Tissue Samples” on page 144.

4. Load the sample plate into the MALDI sample module.

See “Loading a Sample Plate into the MALDI Sample Module” on page 56.

5. On the Windows taskbar, choose Start > All Programs > Xcalibur > LTQ Tune.

The Tune Plus window opens (Figure 22 on page 36).

6. Choose File > Open and select the tune file for your analyte of interest. 
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For best results, prepare a test sample spot and determine the optimal tune parameters for 
your sample (see Table 5 on page 62) as described in “Testing the MALDI Matrix” on 
page 143.

7. Set up the scan parameters for the LTQ XL mass spectrometer.

See “Acquiring Sample Data Interactively in Tune Plus” on page 95. 

8. Choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page shown by default (Figure 32 
on page 58).

9. Click the Tissue Imaging tab.

The Tissue Imaging page opens (Figure 96 on page 147).

10. Select the Use Tissue Imaging Feature check box.

11. Click the Open button.

The Open Tissue Position File dialog box opens. 

12. Select the MALDI position file for the sample plate you are analyzing, and then click 
Open.

The image stored in the MALDI position file appears in the image view at the bottom of 
the MALDI Source dialog box.

13. Select the tissue area that you want to scan. If you make changes that affect the MALDI 
position file, save the changes to a new MALDI position file.

14. Click Apply.

15. In the MALDI Source dialog box, click the Acquire tab.

The Acquire page opens (Figure 102).

Figure 102. Acquire page 

IMPORTANT  The setting for Microscans in the Define Scan dialog box must match 
the setting for the Microscans per Step in the MALDI Source dialog box - Control 
page.
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16. In the Folder box, type the folder location or browse to select the folder.

17. In the File Name box, specify the file name.

The file name consists of three elements separated by underscores: the base file name, the 
sample position, and the suffix. Tune Plus automatically fills in the sample position with 
“TI” (for tissue imaging) and the suffix with a date stamp.

18. (Optional) In the Sample Name box, type the sample name. 

19. (Optional) In the Comment box, type additional comments about the sample or 
experiment. 

20. Click the Control tab.

The Control page opens (Figure 102 on page 158).

21. Under MALDI Settings, make sure ASF is Off.

22. Under Acquisition settings, type a name for the data file to be acquired.

23. Click Apply.

24. Click the Acquire Data button.

The laser starts firing. The system starts scanning and acquiring data to an Xcalibur raw 
data file.

25. To stop data acquisition before the end of the sample, click the Acquire Data button 
again.

The MALDI source goes into Standby mode.

Using an Instrument Method to Acquire Data

To acquire a data file using a stored instrument method 

1. Prepare the sample plate and load it into the MALDI sample module.

2. Start Tune Plus.

3. Choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page shown by default (Figure 32 
on page 58).

4. Click the Tissue Imaging tab.

The Tissue Imaging page opens (Figure 96 on page 147).

5. Select the Use Tissue Imaging Feature check box.

6. Click the Open button.

The Open Tissue Position File dialog box opens. 
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7. Select the MALDI position file for the sample plate you are analyzing, and then click 
Open.

The image stored in the MALDI position file appears in the image view at the bottom of 
the MALDI Source dialog box.

8. Click the Acquire tab.

The Acquire page opens (Figure 102 on page 158).

9. Make the appropriate entries and selections for the data file location and name. See 
step 16 on page 159.

10. Select the Use Instrument Method check box (Figure 103).

Figure 103. Top portion of the Acquire page

11. In the Instrument Method box, select a tissue imaging method.

For information on creating an instrument method, see “Creating an Instrument Method 
for Tissue Imaging” on page 162.

12. In the Tissue view at the bottom of the page, select the area of interest.

13. Click Apply.

14. Click the Acquire Data button.

The laser starts firing. The system starts scanning and acquiring data as specified in the 
instrument method to an Xcalibur raw data file.

When the system completes the method, the MALDI source returns to Standby mode.
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Acquiring Mass Spectral Data from Tissue Slides Using Xcalibur
You can automate the collection of mass spectral data for a tissue sample by creating a MALDI 
position file, a tissue imaging instrument method, and an acquisition sequence. Use Tune Plus 
to create MALDI position files and tune files and use the Xcalibur data system to create 
instrument methods and acquisition sequences.

The MALDI position file contains a bitmap image of the tissue slides and the MS scanning 
parameters, including the plate motion. The instrument method contains the tune file created 
for the analytes of interest (see “Tuning on an Analyte” on page 62) and the experiments to be 
performed by the LTQ XL mass spectrometer. Each row of the acquisition sequence contains 
information to acquire a data file, including the data file name, the instrument method, and 
the MALDI position file.

To automatically acquire a set of *.raw data files in Xcalibur

1. Create a tune file for your analytes (see “Tuning on an Analyte” on page 62).

2. Prepare the tissue slides (see “Preparing Tissue Slides” on page 136) and load them onto 
the adapter plate (see “Loading the Tissue Slides onto the Adapter Plate” on page 137). 

Because a tissue imaging instrument method must be accompanied by a MALDI position 
file, do step 3, step 8, or both to create a MALDI position file.

3. Take a (600 ppi) scan of the tissue slides (see “Acquiring a Bitmap Image with an External 
Scanner” on page 139). Import this image onto the Tissue Imaging page of the MALDI 
Source dialog box and create a MALDI position file.

4. (Optional) Test the matrix and optimize the laser energy, number of microscans, and 
microscans per step (see “Testing the MALDI Matrix” on page 143). 

5. Apply the MALDI matrix to your tissue sample (see “Applying the MALDI Matrix to the 
Tissue Samples” on page 144).

6. Take a second optical scan of the sample plate with the matrix applied.

7. Load the sample plate into the MALDI sample compartment (see “Loading a Sample 
Plate into the MALDI Sample Module” on page 56).

8. (Optional) Take a scan of the target area with the MALDI camera and create a MALDI 
position file.

Taking a scan of the entire tissue using the MALDI camera can be quite time consuming. 
To reduce the amount of time required to produce an image of the desired target area, 
acquire a bitmap image (600 ppi) of the entire tissue using the external scanner. Import 
this image onto the Tissue Imaging page, and then select a portion of the plate to be 
scanned with the MALDI camera.

9. (Optional) Acquire a test data file. See “Interactively Acquiring Data from Tissue 
Samples,” on page 157.

10. Create an instrument method for tissue imaging. See the next topic. 
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11. Create an acquisition sequence (see “Creating an Acquisition Sequence for Tissue 
Imaging” on page 163).

12. Run the sequence (see “Acquiring Raw Data Files in Sequence Setup” on page 128).

Creating an Instrument Method for Tissue Imaging

“Creating an Instrument Method” on page 113 provides more information on creating 
instrument methods. This procedure describes the settings required to create a tissue imaging 
instrument method.

To create a tissue imaging instrument method

1. On the Windows taskbar, choose Start > All Programs > Thermo Xcalibur > Xcalibur.

The Xcalibur Home Page opens (Figure 67 on page 114). 

2. Click the Instrument Setup button.

The Instrument Setup window opens (Figure 68 on page 115). 

3. In the MALDI settings area, for Plate motion, select Tissue Imaging (Figure 104).

Figure 104. MS Detector Setup page

When you select Tissue Imaging, Automatic Spectrum Filter (ASF) becomes unavailable.

4. In the ASF Off Settings area, for Microscans per step, type or select the number of 
microscans per step. 

A step is a change in the plate position. The position of the laser is static. The MALDI 
X-Y stage moves the tissue plate as specified by the plate motion settings in the MALDI 
position file.

Note  For Xcalibur version 2.0.7 or earlier, the path is Start > All Programs > 
Xcalibur > Xcalibur.
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When you create a tissue imaging instrument method, you can overwrite the microscans 
setting in the tune file. When you increase the number of microscans per step, you also 
increase the acquisition time.

5. Set up the scan events.

6. Save the instrument method. Use a name that you can identify as a tissue imaging 
instrument method.

Creating an Acquisition Sequence for Tissue Imaging

You must specify a position file for each row in the sequence that contains a tissue imaging 
instrument method. You can use the same position file or different position files for every row 
of the sequence.

To specify the position file in an Xcalibur sequence list, follow these procedures:

• “Specifying the Same Position File for the Entire Sequence,” next section

• “Specifying a Different Position File for Each Sequence Row” on page 166 

Specifying the Same Position File for the Entire Sequence

To specify the same position file for the entire sequence

1. Choose Setup > MALDI Source.

The MALDI Source dialog box opens with the Control page shown by default (Figure 95 
on page 146).

2. Click the Tissue Imaging tab.

The Tissue Imaging page opens (Figure 96 on page 147).

3. Select the Use Tissue Imaging Feature check box.

4. Click the Open button.

The Open Tissue Position File dialog box opens. 

5. Select the MALDI position file of interest, and then click Open.

6. Select the entire path and file name of the file including the .MALDIpos file extension 
(Figure 105 on page 164).

IMPORTANT  The number of microscans (in the Tune file) must match the number 
of microscans per step (in the instrument method).
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Figure 105. Selected tissue position file

7. Press CRTL+C to copy the name of the MALDI position file, including its file extension, 
to the Clipboard.

8. From the Windows taskbar, choose Start > All Programs > Xcalibur > Xcalibur.

The Xcalibur Home Page opens (Figure 67 on page 114). 

9. Click the Sequence Setup button.

The Sequence Setup window opens (Figure 78 on page 124). 

10. Choose File > New. 

The New Sequence Template dialog box opens (Figure 79 on page 125).

11. In the Samples area, in the Initial Vial Position box, select A1 (Figure 106), which is the 
default vial position for the New Sequence Template.

Figure 106. Selecting the text in the Initial Vial Position box

12. Press CRTL+V to paste the name of the MALDI position file from the Clipboard into the 
Initial Vial Position box (Figure 107 on page 165).

Default vial position
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Figure 107. MALDI position file pasted into the Initial Vial Position box

13. In the Samples area, in the Injections per Sample box, type a number to specify the 
number of data files you want to acquire.

14. In the General area, make the following entries and selections:

• In the Base File Name box, type a file name. Xcalibur does not accept spaces in base 
file names.

• In the Path box, type or browse to an appropriate directory.

• In the Instrument Method box, browse to the folder where you store your instrument 
methods, and select a tissue imaging method.

15. Use the default settings in the remaining areas of the template.

16. Click OK.

The New Sequence Template dialog box closes and the sequence list appears in the 
Sequence Setup view (Figure 108 on page 166).

Last few characters in the 
filename of the MALDI 
position file
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Figure 108. Sequence file with tissue imaging method and position file

17. Save the sequence file.

Specifying a Different Position File for Each Sequence Row

To specify a different position file for each row of the sequence

1. Create an acquisition sequence as described in “Creating an Acquisition Sequence” on 
page 123.

2. Follow step 1 to step 7 on page 164 to copy the name of the position file from the Tissue 
Position File of the MALDI Source dialog box to the Clipboard.

3. In the sequence row of interest, place the cursor in the Position box.

4. Press F2 twice. 

The Cell Text dialog box opens (Figure 109).

Figure 109. Cell Text dialog box

5. Paste the text into the Cell Text box. 

Figure 110 on page 167 shows a text string pasted into the Cell Text box.

Tissue imaging method MALDI position file
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Figure 110. Cell Text dialog box
\

6. Click OK. 

The text string appears in the Position cell of the sequence list.

Checking the Acquisition Sequence

For the MALDI LTQ XL system, sequence rows contain standard runs or tissue imaging runs: 

• A tissue imaging run includes a tissue imaging instrument method and a MALDI 
position file. A tissue imaging method is an instrument method that has Tissue Imaging 
selected for the plate motion. Figure 111 shows the MALDI settings area of the 
Instrument Setup view with Tissue Imaging selected as the Plate motion.

• A standard run includes a non-tissue imaging instrument method and a well plate 
location. 

Figure 111. MALDI settings in the Instrument Setup view 

When you select a tissue imaging method for a sequence row, you must specify a MALDI 
position file in the Position column for that row. See Figure 108 on page 166.
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When you submit a sequence to the acquisition queue, Xcalibur does not check the sequence 
to verify that each row contains a valid instrument method and position type. When a 
sequence row reaches the front of the queue, the acquisition server sends out a Prepare for 
Run command. If the sequence row contains a mismatched instrument method and position 
type, the sequence pauses and the program generates an error message. When you do not 
match the instrument method to the position type, the following message appears:

LTQ XL MS device reported a failure during “Prepare For Run” command.

The sequence has been paused.
To resume the list, go to the “Samples” main menu
and uncheck the “Pause Analysis” menu item.

For more information about acquisition errors, open the LTQ XL Instrument Console 
window:

To open the LTQ XL instrument console window

1. On the right side of the Windows taskbar, double-click the LTQ XL Instrument 
Console button.

The LTQ XL Instrument Console opens. 

Figure 112 shows the error message that the system generates when it attempts to initiate 
a run for a sequence row containing a tissue imaging instrument method and a well 
position. 
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Figure 112. LTQ XL Instrument Console

Error message
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Identifying Proteins Using BioWorks

This chapter briefly describes how to use BioWorks™ 3.3.1 to analyze your MALDI MS/MS 
data. It also highlights the search parameters that are specific for ions generated by the 
MALDI source.

After you have completed the automated analysis of your protein digest samples, you can use 
BioWorks to search protein, nucleotide, and genomic databases from your RAW file. Use 
BioWorks to cross-correlate MS/MS mass spectra from peptides with the theoretical mass 
spectra produced from sequences generated from either a protein or translated nucleotide 
FASTA database.

For more information about BioWorks, refer to the BioWorks User Guide and Help.

Using BioWorks to Identify Proteins
To analyze your MALDI MS/MS data with BioWorks, complete the following procedures:

• “Opening the RAW Data File,” next section

• “Defining the Search Parameters” on page 172 

• “Modifying the DTA Generation Parameters” on page 174 

• “Setting SEQUEST Search Parameters” on page 175 

• “Searching and Viewing the Results” on page 178 

Contents

• Using BioWorks to Identify Proteins

• Opening the RAW Data File 

• Defining the Search Parameters 

• Modifying the DTA Generation Parameters 

• Setting SEQUEST Search Parameters 

• Searching and Viewing the Results 
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Opening the RAW Data File
To start BioWorks and open a MALDI data file

1. On the Windows taskbar, choose Start > All Programs > Thermo Xcalibur > Xcalibur > 
BioWorks Browser.

The BioWorks Browser window opens.

2. Choose File > Open Analysis file (.RAW)

The Open RAW File dialog box opens. 

3. Select a RAW file to be analyzed.

4. Click Open.

The BioWorks Browser window changes to display the chromatogram of the RAW file 
with the mass spectrum below it. The chromatogram of a MALDI experiment displays 
relative or absolute abundance of the total ion current versus time (min).

You are now ready to define the search parameters as described in the procedure “Defining the 
Search Parameters” on page 172.

Defining the Search Parameters
BioWorks contains the SEQUEST™ application that enables you to search protein and 
peptide databases. Use SEQUEST to cross-correlate uninterpreted MS/MS mass spectra of 
peptides with single-letter-coded amino acid sequences from protein databases or with 
three-letter-coded nucleotide sequences from nucleotide databases.

To set and save search parameters

1. Choose Actions > SEQUEST Search. 

The SEQUEST Search dialog box opens with the Basic page displayed by default 
(Figure 113 on page 173).

Note  For Xcalibur version 2.0.7 or earlier, the path is Start > All Programs > 
Xcalibur > Xcalibur > BioWorks Browser.

Note  The default SRF file name is the name of your RAW file with the .srf extension. 
Thermo Fisher Scientific recommends that you create a unique name for your SRF 
file. The default location for your search results is \Xcalibur\sequest\.
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Figure 113. MALDI settings on the SEQUEST Search dialog box Basic page

2. In the Location of Search Results area, in the File/Folder box, type your SRF file name. 

3. From the Instrument type list, select vMALDI LTQ.

The Use charge state, MSn level, and Activation type settings are automatically changed 
to match the vMALDI LTQ instrument type.

4. Modify the DTA Generation settings as defined in “Modifying the DTA Generation 
Parameters” on page 174.

5. Define and save the search parameters as defined in “Setting SEQUEST Search 
Parameters” on page 175.

6. In the SEQUEST Search dialog box, click Start Search to begin the search analysis:

• The SEQUEST Search box closes.

• The SEQUEST Progress box opens, showing the progress of the search.

Displays the DTA Generation 
Parameters dialog box

Displays the SEQUEST 
Search Parameters 
dialog box
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• When you save the parameters in the SEQUEST Search dialog box and start the 
search, these parameters are written to the .params file in the Xcalibur results 
directory.

To view and interpret the SEQUEST search results, see “Searching and Viewing the Results” 
on page 178.

Modifying the DTA Generation Parameters
Use the DTA Generation Parameters dialog box to modify the .dta generation parameters. For 
MALDI data, use the DTA Generation settings described in this procedure.

To modify the .DTA generation parameters

1. On the Basic page of the SEQUEST Search dialog box, click Modify (Figure 113 on 
page 173). 

The Dta Generation Parameters dialog box is displayed.

2. In the MW range box, type 500.00-4000.00 (Figure 114).

Figure 114. DTA Generation Parameters dialog box

3. For Threshold, select the Absolute option and type 100 in the Threshold box.

4. In the Minimum ion count box, type 5.

5. Select the Make these values the default DTA Generation Parameters for this type of 
instrument check box. 

Your settings are saved so that you can reuse them the next time you select this instrument 
type for your search.
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6. Click OK. 

The SEQUEST Search parameters dialog box opens (Figure 113 on page 173).

7. Continue setting the parameters for the SEQUEST Search dialog box. See “Setting 
SEQUEST Search Parameters” on page 175.

Setting SEQUEST Search Parameters
The search parameters described in this procedure are typically used for tryptic digests of 
proteins.

To set the SEQUEST search parameters

1. On the Basic page of the SEQUEST Search dialog box, in the Perform Search area, click 
Edit next to the Search parameters box (Figure 113 on page 173). 

The SEQUEST Search Parameters dialog box opens with the Basic page displayed by 
default (Figure 115 on page 176).
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Figure 115. Basic page

2. In the Parameters file box, type a file name for this parameters file.

3. From the Database list, select a FASTA file. This search example uses bovine.

4. From the Enzyme list, select Trypsin (KR) if this enzyme was used to digest your protein.

5. In the Missed cleavage sites box, type 2.

6. In the Peptide tolerance box, type 2.000.

7. From the Fragment ions tolerance list, select 1.0.

8. In the Number results scored box, type 250.
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9. Click the Modifications tab.

The Modifications page opens (Figure 116).

Figure 116. Modifications page

10. In the Differential/PTM area, in the AA column, type the one-letter abbreviation for the 
amino acid. 

Note  Differential modifications, also known as variable or amino acids modifications, 
are mainly used for determining post translational modifications (PTMs). Some 
phosphorylated peptide serines are modified and some are not modified. Static 
modifications apply the same specific mass to all occurrences of that named amino 
acid, as in an exhaustive chemical modification. 
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11. For each amino acid, click the corresponding cell in the Mass column and type the mass 
of the modification, or right-click the cell and choose a specific modification. The mass of 
the modification or the selected item appears. See Figure 116 on page 177.

12. Click Save.

The SEQUEST Search Parameters dialog box opens with the Basic page displayed by 
default (Figure 115 on page 176).

13. Continue setting the parameters for SEQUEST from step 6 in the procedure “Defining 
the Search Parameters” on page 172.

Searching and Viewing the Results
When the search is complete, the SEQUEST Progress message box closes. The BioWorks 
Browser changes to display the chromatogram (top pane), the search results in a summary 
table (bottom pane), and .dta files in the Info Bar (left pane). See Figure 117 on page 179. 
Each pane provides unique information you can use to analyze your search results. The panes 
contain the following:

• The Chromatogram window displays a visual depiction of the MALDI experiment with 
total ion current versus the time for the experiment.

• The Results table shows the probability calculations, scores, and other values for the 
matching peptides and proteins from the SEQUEST search. 

• The DTA Information in the Info Bar pane displays the scans, the charge states, and the 
time required to process each .dta file. 
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Figure 117. BioWorks Browser window showing the MALDI data search results

The SEQUEST Results report displays a list of matching peptide and protein sequences with 
various probability calculations indicating how good the match is for your peptide or protein. 
Also, the protein and peptide summaries can be exported to Microsoft™ Excel™ for further 
analysis or archiving. 

For additional information on setting filters, accessing other views, and interpreting your 
search results, refer to the BioWorks User Guide.

Infobar Buttons for accessing
other views

Chromatogram

Protein rowResults tableDTA Information
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ProteoMass Calibration Kit

This appendix describes how to prepare the calibration and sensitivity test spots.

IMPORTANT  Use clean and dry sample plates to prepare the calibration and sensitivity 
test spots. To ensure dryness, store the sample plate under vacuum in the MALDI sample 
module as you prepare the calibration mixes.

Contents

• Calibration Kit Description 

• Preparing the Mass Calibration Targets 

• Preparing the Sensitivity Test Targets 

CAUTION  Store and handle all chemicals in accordance with standard safety procedures. 
The Material Safety Data Sheets (MSDSs) describing the chemicals being used are to be 
freely available to lab personnel for them to examine at any time. Material Safety Data 
Sheets (MSDSs) provide summarized information on the hazard and toxicity of specific 
chemical compounds. MSDSs also provide information on the proper handling of 
compounds, first aid for accidental exposure, and procedures for the remedy of spills or 
leaks. Producers and suppliers of chemical compounds are required by law to provide their 
customers with the most current health and safety information in the form of an MSDS. 
Read the material safety data sheets for each chemical you use.

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear protective gloves when you use solvents or corrosives. Refer to your supplier's 
Material Safety Data Sheet (MSDS) for the proper handling of a particular solvent or 
compound. 

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear safety glasses when you use solvents or corrosives. Refer to your supplier's 
Material Safety Data Sheet (MSDS) for the proper handling of a particular solvent or 
compound. 
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Calibration Kit Description
Calibration Kit Description
The Sigma ProteoMass™ Calibration Kit (MS CAL4) contains a range of standard peptides 
for the purpose of calibrating and testing the MALDI LTQ XL mass spectrometer. The kit 
provides high-purity, low-alkali metal solvents, and recrystallized matrices, and provides 
standards which are ideal for most applications. 

Storage/Stability 

The kit is shipped at ambient temperature. Store the kit at 2 to 8 °C. Matrices, after 
reconstitution in solvent, are stable for approximately one week at room temperature if 
protected from light. Some methionine oxidation can occur over time in MRFA [a small 
peptide (methionine-arginine-phenylalanine-alanine)], which is one of the peptides in the 
Normal Mass Calibration Mix.

Matrix and Solvents

Recrystallized alpha-cyano-4-hydroxycinnamic acid comes in 2.0 mL amber vials. Solvents 
come in high-density polyethylene bottles. See Table 25 for more details.

ProteoMass Normal Mass Calibration Mix (Product Code C 9241)

The normal mass calibration mix is supplied in clear 0.5-mL vials, containing optimal 
quantities of the standard peptides indicated in Table 26. Each kit contains five vials. 

Table 25. Matrix and solvents

Product code CAS number Product Amount

C 8982 28166-41-8 alpha-cyano-4-hydroxycinnamic acid 5 × 10 mg

T 3693 76-05-1 1% trifluoroacetic acid (TFA) solution 4 mL 

A 8596 75-05-8 Acetonitrile 30 mL 

E 7023 64-17-5 Ethanol, 200 proof, molecular biology grade 10 mL 

Table 26. ProteoMass Normal Mass Calibration Mix for the normal mass range

Peptide CAS number (M+H)+ Monoisotopic mass

MRFA 67368-29-0 524.27

Bradykinin 1-7 23815-87-4 757.40

Bradykinin 5979-11-3 1060.57

Angiotensin I 70937-97-2 1296.69

Neurotensin 58889-67-1 1672.92

Renin Substrate 20845-02-7 1758.93
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ProteoMass High Mass Calibration Mix (Product Code C 9366)

The High Mass Calibration Mix is supplied in clear 0.5-mL vials, containing optimal 
quantities of the standard peptides indicated in Table 27. Each kit contains five vials of the 
High Mass Calibration Mix.

ProteoMass Angiotensin II Sensitivity Standard (A 9854)

The sensitivity standard is supplied in clear 0.5 mL vials. Each vial contains 500 pmol of 
angiotensin II. 

Preparing the Mass Calibration Targets
In addition to the solvents, reagents, and protein mixes included in the ProteoMass 
Calibration kit, you must have extra 1.7-mL centrifuge tubes and pipettes to prepare and spot 
the calibration samples.

To prepare the calibration targets used to calibrate the normal and high mass range of the 
MALDI LTQ XL system, follow these procedures:

• “Preparing the Solvent Mixtures,” next section

• “Reconstituting the Calibration Mixes” on page 184 

• “Preparing the Matrix Solution for the Calibration Targets” on page 185 

• “Preparing the Calibrant/Matrix Mixtures” on page 185 

• “Spotting the Calibrant/Matrix Mixtures on the Sample Plate” on page 186 

Table 27. ProteoMass High Mass Calibration Mix for the high mass range

Peptide CAS number (M+H)+ Monoisotopic mass

MRFA [67368-29-0] 524.27

Bradykinin [5979-11-3] 1060.57

ACTH 1-16 [5576-42-1] 1936.99

Melittin [20449-79-0] 2845.75

ACTH 7-38 [68563-24-6] 3657.93
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Preparing the Solvent Mixtures

Use these solvent mixtures to prepare the calibrant/matrix mixtures:

• 0.1% by volume TFA in water (10-fold dilution of the 1% TFA solution in the kit)

• Solvent 1: a solution of 80% LCMS-grade water, 20% acetonitrile (v/v)

• Solvent 2: a solution of 3% (0.1% TFA in water), 13% ethanol, 84% acetonitrile (v/v/v)

To prepare 1 mL of 0.1% TFA in water

Mix 100 μL of 1% TFA (provided in the kit) with 900 μL of LCMS-grade water (or 
18 MΩ-cm deionized water) in a 1.7-mL microcentrifuge tube.

To prepare 1 mL of Solvent 1

Mix 800 μL of LCMS-grade water (or 18 MΩ-cm deionized water) with 200 μL of 
acetonitrile in a 1.7-mL microcentrifuge tube. 

To prepare 1 mL of Solvent 2

Mix 30 μL of the 0.1% TFA solution prepared above with 130 μL of 200-proof ethanol 
(provided in the kit) and 840 μL of acetonitrile (provided in the kit). 

Reconstituting the Calibration Mixes

The reconstituted calibration mixes must sit at room temperature for 30 minutes before you 
can use them. To save time, reconstitute the calibration mixes that you plan to use before you 
prepare the matrix solutions. 

• To calibrate the MALDI LTQ XL system in the normal mass range, reconstitute the 
Normal Mass Calibration Mix. 

• To calibrate the MALDI LTQ XL system in the high mass range, reconstitute both the 
Normal and High Mass Calibration Mixes.

To reconstitute the Normal Mass Calibration Mix

1. Add 58 μL of Solvent 1 to a vial containing the Normal Mass Calibration Mix. 

2. Incubate the vial for 30 minutes at room temperature. 

To reconstitute the High Mass Calibration Mix

1. Add 150 μL of Solvent 1 to a vial containing the High Mass Calibration Mix.

2. Incubate the vial for 30 minutes at room temperature.
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Preparing the Matrix Solution for the Calibration Targets

To prepare the 10 mg/mL matrix stock solution 

1. Add 0.5 mL of Solvent 2 to one vial of alpha-cyano-4-hydroxycinnamic acid (5 mg in a 
1.7-mL microcentrifuge tube).

2. Vortex or sonicate the mixture until the matrix is completely dissolved. 

To prepare the 3.5 mg/mL matrix solution

1. Transfer 35 μL of the 10 mg/mL matrix stock solution prepared above to a 
microcentrifuge tube.

2. Add 65 μL of Solvent 2 to the microcentrifuge tube. 

3. Label the tube, and briefly vortex the tube. 

Preparing the Calibrant/Matrix Mixtures

Depending on the mass range that you want to calibrate, prepare one or both of the following 
calibrant/matrix mixtures.

To prepare the calibrant/matrix mixture for the normal mass range

1. If you have not already done so, reconstitute a vial of the Normal Mass Calibration Mix as 
described in “Reconstituting the Calibration Mixes” on page 184.

2. Transfer 5 μL of the reconstituted normal mass calibration mix to a microcentrifuge tube.

3. Add 45 μL of the 3.5 mg/mL matrix solution to the microcentrifuge tube.

4. Label the tube, and briefly vortex the tube.

To prepare the calibrant/matrix mixture for the high mass range

1. If you have not already done so, reconstitute a vial of the High Mass Calibration Mix as 
described in “Reconstituting the Calibration Mixes” on page 184.

2. Transfer 5 μL of the reconstituted High Mass Calibration Mix to a microcentrifuge tube.

3. Add 45 μL of the 3.5 mg/mL matrix solution to the microcentrifuge tube.

4. Label the tube, and briefly vortex the tube.
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Spotting the Calibrant/Matrix Mixtures on the Sample Plate

To spot the calibrant/matrix mixtures on the sample plate

1. For each calibrant/matrix mixture that you plan to use, spot five or more sample wells on 
the sample plate with 1.5 μL of the calibrant/matrix mixture per well. 

2. Gently use the pipette tip to spread the calibration solution out to the edges of the 
sample well. 

The sample must touch the edges of the well engraving to ensure even drying and 
uniform distribution. You can spread the solution slightly outside of the sample circle if 
necessary. 

3. Continue spotting the sample wells until you have created five or more homogeneous 
spots.

4. Allow the sample spots to dry at room temperature for 1 to 2 minutes. 

Preparing the Sensitivity Test Targets
Thermo Fisher Scientific recommends that you check the sensitivity of the MALDI LTQ XL 
system before performing analyses on low-concentration samples. The following procedure 
describes how to prepare the sensitivity test targets.

To prepare the sensitivity test targets

1. Prepare Solvent 3, a solution of 50:50 acetonitrile /0.1% TFA in water (v/v):

a. Transfer 100 μL of 0.1% TFA in water to a microcentrifuge tube. 

For instructions on preparing a solution of 0.1% TFA in water, see “Preparing the 
Solvent Mixtures” on page 184.

b. Add 100 μL of acetonitrile to the tube and mix.

2. Reconstitute a vial of angiotensin II:

a. Add 625 μL of LCMS-grade water (or 18 MΩ-cm deionized water) to a vial of 
angiotensin II. 

The 0.5-mL vials contain 500 pmol of angiotensin II. The concentration of the 
reconstituted solution is 800 fmol/μL angiotensin II. 

b. Incubate the vial for 30 minutes at room temperature. 

3. Prepare a 40 fmol/μL solution of angiotensin II:

a. Transfer 5 μL of the reconstituted angiotensin II to a clean, dry microcentrifuge tube.

IMPORTANT  If the sample does not spread homogeneously over the well, do not use the 
spot for calibration.
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b. Add 95 μL of water to the tube and vortex briefly. 

The final concentration of this solution is 40 fmol/μL angiotensin II. 

4. Prepare a 4 fmol/μL solution of angiotensin II:

a. Transfer 5 μL of the 40 fmol/μL angiotensin II solution from step 3 to a clean, dry 
microcentrifuge tube.

b. Add 45 μL of water to the tube and vortex briefly. 

The final concentration of this solution is 4 fmol/μL angiotensin II. 

5. Prepare a 1 mg/mL matrix solution:

a. Transfer 10 μL of the stock matrix solution (10 mg/mL) to a clean, dry 
microcentrifuge tube.

b. Add 90 μL of Solvent 3 and vortex. 

The final concentration of this solution is 1 mg/mL matrix. 

6. Prepare a 10 fmol angiotensin II target:

a. Transfer 5 μL of the 40 fmol/μL angiotensin II solution prepared in step 3 to a clean, 
dry microcentrifuge tube. 

b. Add 5 μL of the 1 mg/mL matrix solution prepared in step 5 to the tube.

c. Vortex briefly, and spot 0.5 μL (10 fmol of angiotensin II) onto the sample plate. 

7. Prepare a 1 fmol angiotensin II target:

a. Transfer 5 μL of the 4 fmol/μL Angiotensin II solution prepared in step 4 to a clean, 
dry microcentrifuge tube.

b. Add 5 μL of the 1 mg/mL matrix solution prepared in step 5 to the tube. 

c. Vortex briefly, and spot 0.5 μL (1 fmol angiotensin II) onto the sample plate. 
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Sample Preparation

The quality of your MALDI spectra highly depends on sample preparation. The optimal 
conditions can vary considerably from analyte to analyte. Experiment to find the best way to 
prepare your analyte of interest. This appendix contains guidelines on how to prepare and 
deposit samples to be analyzed with the MALDI LTQ XL system.

Contents

• Matrix

• Matrix Solvent 

• Matrix-to-Analyte Ratio 

• Sample Purification 

• Sample Deposition Techniques 

• MALDI Sample Preparation Guidelines 

CAUTION  Store and handle all chemicals in accordance with standard safety procedures. 
The Material Safety Data Sheets (MSDSs) describing the chemicals being used are to be 
freely available to lab personnel for them to examine at any time. Material Safety Data 
Sheets (MSDSs) provide summarized information on the hazard and toxicity of specific 
chemical compounds. MSDSs also provide information on the proper handling of 
compounds, first aid for accidental exposure, and procedures for the remedy of spills or 
leaks. Producers and suppliers of chemical compounds are required by law to provide their 
customers with the most current health and safety information in the form of an MSDS. 
Read the material safety data sheets for each chemical you use.

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear protective gloves when you use solvents or corrosives. Refer to your supplier's 
Material Safety Data Sheet (MSDS) for the proper handling of a particular solvent or 
compound. 

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. Wear 
safety glasses when you use solvents or corrosives. Refer to your supplier's Material Safety 
Data Sheet (MSDS) for the proper handling of a particular solvent or compound. 
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Matrix
The compound used as the MALDI matrix must meet the following requirements:

• Be capable of co-crystallization with the analyte

• Be soluble in a solvent that is compatible with the analyte

• Have a high absorptivity coefficient at the UV wavelength of 337.7 nm emitted by the 
MALDI laser

• Be chemically non-reactive with the analyte

• Must not sublimate at a pressure of 70 mTorr, the pressure maintained within the sample 
chamber of the MALDI source

Figure 118 shows two compounds commonly used as matrices for peptide analysis with 
MALDI, alpha-cyanohydroxycinnamic acid (CHCA) and 2,5-dihydroxybenzoic acid (DHB). 

Figure 118. Matrix compounds

DHB has a lower internal energy upon desorption than CHCA, and produces less 
fragmentation of analytes. Consequently, DHB is sometimes preferred to CHCA, particularly 
for use with labile biological molecules, such as carbohydrates and proteins with post- 
translational modifications. Recrystallized matrices are preferred. Table 28 lists suggested 
suppliers of recrystallized matrices.

Table 28. Ordering information for CHCA and 2, 5-DHB matrixes

Matrix Supplier Part number

CHCA Laser Biolabs, France M001

CHCA Waters 186002331

2,5-DHB Laser Biolabs, France M003

2,5-DHB Waters 186002333

N

OH

OH

O

C

OHO

OH

OH

alpha-cyano-4-hydroxycinnamic acid (CHCA) 2,5-dihydroxybenzoic acid (DHB)
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Matrix Solvent
The solvent used to make the matrix solution can affect the crystallization of the matrix and 
sample. In general, solvent mixtures with higher organic content evaporate more quickly, 
leading to faster crystallization and thinner sample coverage. (Refer to Cohen and Chait, 
19961 for a more detailed description of solvent effects on matrix crystallization.) The solvent 
commonly used for CHCA is 50:50 (0.1% TFA in water)/acetonitrile (v/v). You can use 
another common solvent, 3:13:84 (0.1% TFA in water)/ethanol/acetonitrile (v/v/v), when 
you need a faster evaporation rate. Chromasolv™ or LCMS-grade solvents are recommended.

Matrix-to-Analyte Ratio
The matrix-to-analyte ratio is an important factor in the quality of spectra obtained using the 
MALDI ion source. Many commonly used sample-preparation protocols for MALDI employ 
saturated or near-saturated CHCA. Such concentrations are too high to use with the MALDI 
source, and result in matrix ion signals overwhelming the spectrum. A baseline “hump” in the 
low-mass region (<m/z 1000) might be an indication that too much matrix has been used, 
that the matrix is contaminated, or that the sample plate is dirty. In the case of CHCA, adduct 
peaks (also known as matrix clusters) can appear in the spectrum as a series of peaks with an 
m/z difference of 211 to 212. These adducts are comprised of several molecules of CHCA 
with sodium/and or potassium2,3. 

For samples in the 100 to 500 fmol/μL range, a solution of <2.5 mg/mL CHCA is often a 
good starting point. Lower analyte concentrations require lower matrix concentrations.

Sample Purification
Many common buffers and additives used in handling biological samples can reduce the 
quality of MALDI spectra when present above a particular concentration. These include 
sodium and potassium salts, phosphate buffers, and many detergents and denaturants. Many 
samples need purification to remove these substances before MALDI analysis. (Refer to Mock 
et al., 19924 for more information on problematic compounds.)

A popular purification technique is the use of C-18 containing micro extraction pipette tips 
(such as the Varian OMIX™ tips or Millipore ZipTip™), which allow rapid reverse phase 
purification of small volume protein or peptide samples. Samples can be eluted directly onto 
the MALDI sample plate with the matrix of choice, or can be eluted into a microcentrifuge 
tube with a suitable solvent. The latter option allows for more flexibility in experimenting 
with different matrices and matrix concentrations.

1 Cohen, S.; Chait, B. Anal. Chem. 1996, 68, 31-37. 
2 Keller, B.O. and Li, L. J Am Soc Mass Spec. 2000, 11, 88-93.
3  Harris, W.A.; Janecki, D.J., and Reilly, J.P. Rapid Commun. Mass Spec. 2002, 16, 1714-1722.
4 Mock, K.; Sutton, C.; Cottrell, J. Rapid Commun. Mass Spec. 1992, 6, 233-238. 
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Most samples from in-gel digests need a purification step after digestion, but in-gel digests in 
the high picomolar range might not need the purification step.

Lyophilized protein digests are usually resuspended in 10 to 20% acetonitrile in 0.1% TFA. 
Subsequent dilutions can be made with 18 MΩ -cm or LCMS-grade water. 

Sample Deposition Techniques
Many sample deposition techniques have been used with MALDI. This topic describes two 
common sample deposition techniques: the dried-droplet method and the analyte first 
method. 

The dried-droplet method is used in the sample preparation protocols given in this manual. It 
is also the preferred sample deposition method for use with DHB as well as CHCA. With this 
method, you mix the sample solution and matrix solution, and then load the mixture onto a 
sample plate. You typically use a 1:1 ratio for the sample/matrix mixture, and load the sample 
plate with 0.5 to 1.0 μL of the mixture per spot. You can vary the matrix-to-sample ratio. It is 
important to load the sample/matrix mixture as soon as possible after mixing because crystals 
might form in the mixture. 

The analyte first method is used to improve sensitivity. With this method, you apply 
0.3 to 0.5 μL of sample solution to the sample spot and allow it to dry. Then you apply an 
approximately equal amount of matrix solution to the spot and allow it to dry.

MALDI Sample Preparation Guidelines 
This topic describes sample preparation with either the 2,5-DHB (2,5-dihydroxybenzoic acid) 
or the CHCA (alpha-cyano-4-hydroxycinnamic acid) matrices and contains the following 
procedures:

• “Preparing Samples with the 2, 5-DHB Matrix,” next section

• “Preparing Samples with the CHCA Matrix” on page 193 

• “Preparing Phosphorylated Peptides for a Neutral Loss Experiment” on page 194 

Preparing Samples with the 2, 5-DHB Matrix

The preferred matrix for protein digests and labile molecules is 2,5-dihydroxybenzoic acid 
(2,5-DHB) because it causes less fragmentation than CHCA. You can 
use 50:50 acetonitrile/0.1% TFA in water (v/v), or 20:80 acetonitrile/0.1% TFA in water 
(v/v) as the solvent for a 2,5-DHB matrix. Adding 0.1% TFA maintains the acidity of the 
solution below pH 4.
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To prepare samples with the 2,5-DHB matrix

1. Prepare a stock solution of 50 mg/mL 2, 5-DHB in 50:50 acetonitrile/0.1%TFA. 

2. To prepare the target spots, do one of the following:

• For peptides, prepare a 1:1 sample/matrix mixture, and then spot the sample wells of 
the sample plate with 0.3 to 0.5 μL of this mixture. 

• Spot the sample wells with 0.3 to 0.5 μL of the analyte solution. Allow the spot to 
dry, and then apply the same amount of matrix solution on top of the analyte spots.

• Spot a sample well with the analyte solution. Before the analyte solution drys, spot 
the well with the matrix solution. Using a pipette with a disposable tip, mix the 
analyte and matrix solutions by drawing the solution into and expelling the solution 
from the pipette tip. Make sure the dry sample is no larger than 2 mm in diameter, as 
this is the size of the camera view.

Preparing Samples with the CHCA Matrix

Alpha-cyano-4-hydroxycinnamic acid (CHCA) is a universal type of matrix that can be used 
with non-volatile, thermally labile molecules.

If needed, you can add ammonium citrate dibasic (Sigma P/N 09833 or 09831) to the 0.1% 
TFA solution, for a total ammonium citrate concentration of 2 mM in the 50/50 
acetonitrile/0.1%TFA solvent. Signal suppression might occur above 5 mM ammonium 
citrate. This additive has been shown to help with certain contaminants in samples (high salt 
concentrations, certain buffers, and ionic detergents).

To prepare samples with the alpha-cyano-4-hydroxycinnamic acid (CHCA) matrix

1. Prepare a stock solution of 10 mg/mL CHCA in 50:50 acetonitrile/0.1%TFA. 

This stock CHCA solution can be stored for up to a few weeks in a light-resistant 
container or in a dark location at 20 °C.

2. Prepare a working solution of 1.0 to 2.5 mg/mL CHCA in the same solvent used to 
prepare the stock solution. If samples are at the attomole level, use the lower CHCA 
solution concentration of 0.5 to 1.0 mg/mL.

Use the working CHCA solution to prepare the target spots. 

3. To prepare the target spots, do one of the following:

• Spot the sample wells with 0.5 μl of the analyte solution. Allow the spots to dry, and 
then apply 0.5 μL of the CHCA working solution (1 mg/mL to 2.5 mg/mL) on top 
of the analyte spots. 

• Use the dried-droplet method. Prepare a 1:1 sample/matrix (CHCA working 
solution, 1.0 to 2.5 mg/mL) solution, and then spot the sample wells with 0.5 μL of 
this mixture.
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Preparing Phosphorylated Peptides for a Neutral Loss Experiment

The recommended matrix for observing phosphorylated peptides is 2,5-DHB, making it the 
preferred matrix for the neutral loss, data-dependent method. Samples prepared with CHCA 
tend to show a reduced phosphorylated precursor. Phosphoric acid has been shown to 
improve the sensitivity of the phosphorylated group5.

Preparation of samples containing phosphorylated peptides:

1. Dissolve 2,5-DHB in 50/50 (ACN/0.1% phosphoric acid) solvent

2. Prepare a 1:1 (v/v) matrix to analyte mixture.

3. Load 0.3 to 0.5 μL of this mixture onto each sample well. 

5 Kjellström S. and Jensen O.N. Anal. Chem. 2004, 76, 5109-5117.
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using in data acquisition  102
using in Tune Plus to acquire sample data  102
using in Tune Plus to acquire tissue imaging data  160

Ion Mapping  19
Ion Mapping experiments  21
isolation width, optimizing  105

L
laser energy

manual adjustment  76
semi-automatic tuning  73

LTQ XL
calibration parameters  63
instrument console  168
sample data parameters, setting  95
tuning parameters  63

LTQ XL system, turning on  35

M
MALDI

advantages  4
compared with ESI  4

MALDI LTQ XL system, rebooting  40
MALDI position file

creating using bitmap image  150
creating using the MALDI camera  155

MALDI source
firmware version  32
serial number  32
tuning parameters  66
turning on  37

MALDI, description of  1
mass spectra, viewing  71
materials checklist  33
matrix

applying to tissue samples  144
requirements  190
testing  143

matrix application  145
matrix solution for calibration targets  185
matrix solvent  191
matrix-assisted laser desorption/ionization. See MALDI
matrix-to-analyte ratio  191
microscans per step, effect on acquisition time  163
modifications, setting for a SEQUEST search  177
MS scanning settings (tissue imaging)  150

N
Neutral Loss Ion Mapping experiment  23
nitrogen gas, checking supply  35
noise (grinding) coming from the MALDI sample module  56
normal mass range calibration  79
Nth Order Double Play Data Dependent experiment  14
Nth Order Triple Play experiment  19

O
optical image file, importing  145

P
phosphorylated peptides for neutral loss experiment  194
position files

creating  150
specifying for an Xcalibur sequence  163

Precursor Ion Mapping experiment  25
preinstallation checklist  33
ProteoMass calibration kit  181
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R
raster step size  150
raw files  172
regulatory compliance  iii

S
safety standards  iii
sample deposition  192
sample plate

assembling  55
cleaning  50
disassembling  50
identifying  44
jammed  56
loading  56
spotting calibrant/matrix mixture  186
types  44

sample preparation  191
sample purification  191
scanner  140
scanner frame  140
search parameter files  174
sensitivity test  87
sensitivity test targets, preparing  186
sequences

compatibility between instrument method and position  
167

selecting well locations  126
specifying position files (tissue imaging)  163

SEQUEST
.params file, location of  174
search parameters, setting  175

serial number of MALDI source  32
setting up to acquire data  95
solvent mixtures, preparing  184
space charge effects  76

T
templates, for Data Dependent experiments  10
tissue imaging

acquiring bitmap image  139
acquisition sequence for  163
description  131
instrument method for  162
license  132

tissue samples, applying matrix to  144
tissue slides

loading onto adapter plate  137
preparing  136

total (or full-scan) Ion Mapping experiment  22

tune file parameters  62
tuning, description  26

V
vacuum pressure, checking  36
video camera contrast and brightness, adjusting  47

W
WEEE compliance  v
Wideband Activation, description  4

X
Xcalibur/SEQUEST folder  174

Z
ZoomScan

description  4
in Data Dependent Triple-Play experiment  12
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